# Table of Contents

Chapter 1: Overview ................................................................. 4  
  Introduction to This Guide ................................................... 5  
  Organization of This Guide .................................................. 5  
  Document Conventions ....................................................... 5  
  About Optum ................................................................. 6  
  Contact Us ................................................................. 6  

Chapter 2: Rate Manager Introduction ........................................ 8  
  Introduction ........................................................................ 9  
  Optum-Supplied Rate Files .................................................. 10  
  Database Structure ............................................................. 10  

Chapter 3: Rate Manager User Interface (UI) ............................... 11  
  Accessing Rate Manager ....................................................... 12  
  Rate Manager Main/Home Screen ......................................... 13  
  Advanced Filters Functionality ............................................. 15  
  Multi-User Lock Functionality .............................................. 21  

Chapter 4: Creating/Modifying Pay-Source & Rate Calculator Data . 23  
  Creating a New Pay-Source Record ........................................ 24  
  Creating a New Rate Calculator Record ................................... 25  
  Modifying a Pay-Source & Rate Calculator Data ...................... 26  
  Procedure Based Rate Calculator(s) ....................................... 29  
  Enhanced New York Medicaid APG Pay-Sources ..................... 31  

Chapter 5: Editors Menu ............................................................ 34  
  Editors Overview ............................................................. 35  

Chapter 6: Global Edit Menu ..................................................... 92  
  Global Edit Overview ......................................................... 93  

Chapter 7: Reports Menu .......................................................... 102  
  Reports Overview ........................................................... 103  

Chapter 8: System Administration (Sys Admin) Menu .................... 110  
  Sys Admin Overview ......................................................... 111  

Chapter 9: Utilities Menu .......................................................... 127  
  Import .............................................................................. 128  
  Export ............................................................................. 131  

Chapter 10: Rate Manager Pro ...................................................... 140  
  Rate Manager Pro ........................................................... 141  
  Additional Features ........................................................... 141  

List of Tables ........................................................................... 161  
List of Figures .......................................................................... 162  
Index ..................................................................................... 166
1 Overview

This chapter provides an overview of this manual, and introduction to Rate Manager, and instructions on how to contact Optum.

This chapter contains the following sections:

- Introduction to This Guide
  - Intended Audience
- Organization of This Guide
- Document Conventions
- About Optum
- Contact Us
  - Corporate Address
  - Need Assistance? Contact Optum Client Services
  - Optum Portals
  - Found an Error in This User’s Guide?
1.1 Introduction to This Guide

The Rate Manager User’s Guide contains all the essential information the user will need to be able to navigate and run Rate Manager. Consider this guide your textbook, a ready reference source should you forget a procedure or encounter a problem.

1.1.1 Intended Audience

This guide is directed to:
- Claims Specialists
- Information Technology Personnel
- System Administrators
- Supervisors

1.2 Organization of This Guide

Table 1-1: Guide Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, Overview</td>
<td>Overview of Optum and of this user’s guide.</td>
</tr>
<tr>
<td>Chapter 2, Rate Manager Introduction</td>
<td>Introduction to Rate Manager.</td>
</tr>
<tr>
<td>Chapter 3, Rate Manager User Interface (UI)</td>
<td>Accessing Rate Manager.</td>
</tr>
<tr>
<td>Chapter 4, Creating/Modifying Pay-Source &amp; Rate Calculator Data</td>
<td>Information on how to create a new Pay-Source and Rate Calculator record in Rate Manager.</td>
</tr>
<tr>
<td>Chapter 5, Editors Menu</td>
<td>Overview of Editors in Rate Manager.</td>
</tr>
<tr>
<td>Chapter 6, Global Edit Menu</td>
<td>Overview of Global Edit in Rate Manager.</td>
</tr>
<tr>
<td>Chapter 7, Reports Menu</td>
<td>Overview of Rate Manager reports.</td>
</tr>
<tr>
<td>Chapter 8, System Administration (Sys Admin) Menu</td>
<td>Overview of system administration in Rate Manager.</td>
</tr>
<tr>
<td>Chapter 9, Utilities Menu</td>
<td>Information on Import and Export utilities in Rate Manager.</td>
</tr>
<tr>
<td>Chapter 10, Rate Manager Pro</td>
<td>Overview of the additional features included with the Rate Manager Pro module.</td>
</tr>
<tr>
<td>List of Tables</td>
<td>Index of tables used throughout this guide.</td>
</tr>
<tr>
<td>List of Figures</td>
<td>Index of figures used throughout this guide.</td>
</tr>
<tr>
<td>Index</td>
<td>Quick reference index.</td>
</tr>
</tbody>
</table>

1.3 Document Conventions

This guide uses the following conventions:

- Any screen fields, buttons, tabs, or other controls that you can manipulate are printed in bold type. Keys that you press on the keyboard are also printed in bold type. For example:
- Press the **Exit** button.
- Press the **Enter** key.

- Keyboard keys that you must press simultaneously are printed in **bold** type and separated by a plus (+) sign. For example:
  - Press **Ctrl + C**.

- Links embedded in the text that you can select to jump to another section are in orange. For example:
  - Mapper

- Field names for the C Platform and filenames are italicized. For example:
  - *pricer_rtn_code*
  - *EASYGroup.exe*

- Field description titles are printed in **bold** type:
  - **NICU Accreditation Indicator**

- Legislation titles are italicized. For example:
  - *Balanced Budget Act of 1997*

- CMS Transmittals will be written in the following format:
  - CMS Transmittal No. R2220CP *(Update - Inpatient Psychiatric Facilities Prospective Payment System (IPF PPS) Rate Year 2012)*

---

### 1.4 About Optum

Optum is a health services business dedicated to making the health system work better for everyone. At Optum, we help modernize the health ecosystem, by bringing interoperable and connected technology, real-time information, streamlined administration and managed compliance, risk, and costs.

### 1.5 Contact Us

#### 1.5.1 Corporate Address

Optum
11000 Optum Circle
Eden Prairie, MN. 55344
T 1 + (888) 445-8745
[www.optum.com](http://www.optum.com)

#### 1.5.2 Need Assistance? Contact Optum Client Services

We welcome you as a valued client. Please contact Optum Client Services using one of the methods detailed below.

When opening a ticket with Optum Client Services you will be issued a ticket number. These ticket numbers correlate to individual issues. If you are
experiencing multiple issues, it is recommended that you obtain individual ticket numbers.

When calling Optum Client Services regarding a previously opened ticket, have your ticket number available. If you misplaced or did not receive a ticket number, please ask the technician to provide it to you.

Optum Client Services Phone: 800-999-DRGS (3747)

1. Calls are answered in the order that they are received. If there is a high call volume, calls are held in a queue until a technician becomes available.
2. Calls classified as an industry expert category (i.e., case and reimbursement, logic encoder, etc.) will be escalated to Optum experts.
3. Technicians are available 24/7.

After selecting **Option 6 for Technical Support** you will hear the following choices:

<table>
<thead>
<tr>
<th>Option #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option 1</td>
<td>For password reset, login issues, or expiration error.</td>
</tr>
<tr>
<td>Option 2</td>
<td>For all other issues.</td>
</tr>
</tbody>
</table>

Email: Optum Client Services

1. Include name and number and detailed description of product issue.
2. Response time to email is generally within a few business hours.
3. Service technician has ability to do prior research before calling back.

1.5.3 Optum Portals

For access to announcements, user documentation, notices, release schedules, and much more please visit the Optum Client Portal and/or the Regulatory Portal.

1.5.4 Found an Error in This User’s Guide?

Please feel free to contact our Rate Manager Documentation Team with any errors you may have found within this user’s guide:

Rate Manager Documentation

We welcome feedback from our clients.
2 Rate Manager Introduction

This chapter includes the following sections:

- Introduction
  - Web.Strat™
  - EASYGroup™
- Optum-Supplied Rate Files
  - National Medical Provider Rate Files (NMPRFs)
  - State-Specific Rate Files & TRICARE APC Rate Files
- Database Structure
2.1 Introduction

Through the Web.Strat™ and EASYGroup™ products, Optum provides users with flexible tools for case-mix assignment (grouping) and reimbursement calculation (pricing). In addition, Optum provides users with the capability to triage among available Groupers and Pricers (inpatient, outpatient, and rehabilitation, available for EASYGroup™ only) based on a set of user-defined rules.

User-defined rules for grouping and pricing are specific to a facility, payer, and period of time (effective date). These rules are defined, customized and maintained through Rate Manager. For each facility, payer, and effective date, users can specify:

- Which Grouper type and version, if any, to use to classify patients (e.g., DRGs, AP-DRGs, APCs, APGs, CMGs, etc.).
- Whether code mapping should be completed before calling the selected Grouper.
- Which Pricer, if any, to use to calculate expected reimbursement (e.g., DRG-based prospective payment, per diems, charge reduction, IRF, etc.).

Rate Manager offer a wide range of capabilities to manage and model your current and future reimbursement contracts. With Rate Manager you can:

- Identify your pay-source to the Web.Strat™ product (if applicable).
- Select reimbursement calculations for each pay-source.
- Create hospital-specific reimbursement variables for each pay-source.
- Create pay-source(s) for export to data files used by the EASYGroup™ Optimizer.
- Define the Grouper type and version for a pay-source.
- Load:
  - DRG weights, Length of Stay (LOS) means, and LOS outlier trims.
  - APC or APG weights, rates, and other payment factors.
  - CMG weights, rates, and other payment factors.
  - RUG weights, rates, and other payment factors.
  - HHRG weights, rates, and other payment factors.

2.1.1 Web.Strat™

With Rate Manager, users can customize the grouping and pricing functionality. A data export utility provides the ability to transfer these reference files for use with Web.Strat™.
2.1.2 EASYGroup™

With Rate Manager users can customize the grouping and pricing functionality of the EASYGroup™ product line. Rate Manager is used to build the reference and data files required by the EASYGroup™ products. A data export utility provides the ability to transfer these reference files to other computers and systems.

2.2 Optum-Supplied Rate Files

Optum has the following rate files available for use with Rate Manager. Please refer to the EASYGroup™ User’s Guide for a full listing of all available rate files.

**Important**

In order to ensure regulatory compliance, Rate Manager populates all new fields and their corresponding default values for all existing rate records (i.e., Optum-supplied rates and custom rates). Please review custom rate data sets to ensure processing accuracy when new fields are added.

2.2.1 National Medical Provider Rate Files (NMPRFs)

Each NMPRF contains information related to Medicare reimbursement for a certain time period. These files contain information for Medicare-participating facilities located in all 50 states and Puerto Rico. Each record in the NMPRF contains information about a single facility for a specific time period and may be identified with the appropriate NPI or legacy identifier.

2.2.2 State-Specific Rate Files & TRICARE APC Rate Files

The state-specific rate files and the TRICARE APC Rate Files are a comprehensive source of facility-specific Medicaid or TRICARE inpatient or outpatient reimbursement information. They contain all the specific information or rate variables needed to calculate inpatient or outpatient hospital reimbursements (including inlier, outlier, and transfer payments).

2.3 Database Structure

The Rate Manager databases are organized using the Facility ID/Payer ID/Effective Date or NPI/Taxonomy/Payer ID/Effective Date key fields. Each Facility or NPI/Taxonomy combination can have multiple Payer IDs and each Payer ID can have multiple effective dates. This allows the maintenance of multiple types and years of Groupers and Pricers. Rate Manager’s flexibility allows the user to control which Groupers and Pricers to use for reimbursement calculation.
3 Rate Manager User Interface (UI)

This chapter contains the following sections:

• Accessing Rate Manager
• Rate Manager Main/Home Screen
• Advanced Filters Functionality
  - Advanced Filters Panel
  - Advanced Filter Criteria Screen
• Multi-User Lock Functionality
3.1 Accessing Rate Manager

Users have two ways to access Rate Manager:

- Desktop version - Installed application on your local machine.
- Web version - Network access, not locally installed. Users will navigate to a server/IP address where Rate Manager is housed.

**Note**
If you are unsure which version of Rate Manager you should access please contact your network administrator.

**To Access the Desktop Version of Rate Manager:**
1. Select the Rate Manager icon on your local machine.
2. Enter your **Username** and **Password** (if prompted).
3. Rate Manager will open.

**To Access the Web Version of Rate Manager:**
1. Enter the IP address of the server into a web browser where Rate Manager is hosted (e.g., Windows® Explorer™).
2. Enter your **Username** and **Password** (if prompted).
3. Rate Manager will open.
3.2 Rate Manager Main/Home Screen

The Rate Manager Main Screen or Home screen is the initial screen displayed when first logging into the application.

On this screen users will see the following items (from top to bottom):

- **Welcome**
- **Help**

**Note**

Selecting the Help menu will allow the user to view the Rate Manager About information (i.e., version number(s)), as well as the References screen and Optum’s Privacy Policy screen. The References screen contains files such as: Rate Variable Worksheets (RVWs), Release Notes, User’s Guides, etc.

- **Sign Out**
- **Database Version** - Shows the database version number of Rate Manager that is currently being utilized.
• **Database** drop-down - Shows the current database that you are presently accessing. To switch databases simply select another option in the drop-down (if available).

• Main Menu Options - Main toolbar used for navigating through Rate Manager.

**Note**
The Main Menu options will differ based on how the current user is configured.

For further information on the below menu options please refer to the applicable chapter within this user’s guide.

Users will see the following options:

- **Home**: If you wish to return to the Main/Home Screen at any time, select this option.

- **Editors**
  - **Global Edit**
  - **Reports**
  - **Sys Admin**
  - **Utilities**

• **Search Screen** - Shows all applicable pay-source records available. The Search screen will change based on the filter criteria entered by the user. Detailed information on a pay-source can be viewed/changed by double-clicking on a particular pay-source record in the Search screen. Users can reorganize the order in which the fields are displayed by drag and dropping a column header to it’s desired position. Users can also change the order in which values are displayed by clicking on a column header. This will change the order in which records are seen (ascending/descending).

**Note**
The column and field order within the Search screen will default back to the original order once a user logs out of Rate Manager.

• **Create New** button - To add a new pay-source or rate calculator. Once selected the **Rate Variable** screen will be displayed and the user will be able to enter new pay-source/rate calculator information for the desired care setting.

• **Filters** panel - Users may utilize this panel to search for particular records using the following options:
  - **Facility**
- NPI
- Taxonomy
- Payer ID
- Name
- State/Abbr
- Pricer Type
- Production Date (Rate Manager Pro only)

- **Advanced Filters Panel** - Users may utilize this panel to define more specific search criteria based on available configuration, pricing, editing, and grouping variables.

- **Search** button

### 3.3 Advanced Filters Functionality

#### 3.3.1 Advanced Filters Panel

The **Advanced Filters** panel is located on the bottom-left of the Main/Home Screen, near the **Search** button. This panel contains a drop-down, a preview window, **Add** (only displayed when the search criteria is blank), **Edit** (only appears when a selection is made in the drop-down) and **Clear** buttons.

The Advanced Filters drop-down contains all previously saved search filters. The Preview Window displays the search criteria for the filter. The search criteria can quickly be modified by selecting the check box next to the criteria in the Preview Window. Placing the cursor over each criteria will display the entire criteria string in the Hover Help. Selecting **Add** (only displayed when the search criteria is blank) or **Edit** (only displayed when a search criteria is displayed) will bring up the **Advanced Filter Criteria** screen. Selecting **Clear** will clear any selection in the search filter/criteria.

Enter/select the desired search criteria and then select **Search**. Select **Clear** to erase any input in the above-mentioned fields. When the **Search** button is selected, records meeting the specified criteria are displayed in the **Search** screen. Locate the desired record and double-click any field to view that record.
3.3.2 Advanced Filter Criteria Screen

As mentioned above, the **Advanced Filter Criteria** screen (shown below in Figure 3-3) will appear when **Add** or **Edit** is selected from the **Advanced Filters** panel.
On the Advanced Filter Criteria screen, users will see the following:

- **Create New** button - Select to create a new filter criteria. Once selected, the Create New Filter window will appear (shown below in Figure 3-4). In this window, you can assign a unique name to your search filter using the New Filter Name text box and by selecting Save. If the new filter name already exists, a prompt will appear in which the user will need to select OK to overwrite or Cancel to rename the filter.
Figure 3-4. Create New Filter Screen

- **Custom Filters Panel** - This panel will display all the previously saved search filters in the Name drop-down. Clicking a saved search filter from the drop-down will display the criteria in the **Criteria Grid**.

Figure 3-5. Custom Filters Panel

- **Criteria Grid** - This grid will display the criteria. The grid consists of the following columns: **Condition**, **Variable**, **Comparison**, and **Input**. Selecting a criteria in the grid will display it’s options in the **Criteria Panel**.
- **Remove Button** - Will remove the criteria currently selected in the grid.
- **Clear Button** - Will clear all criteria in the grid.

Figure 3-6. Criteria Grid

- **Criteria Panel** - Users can add search criteria to the filter using the following options:
  - **Condition** - Selecting the **AND** radio button signifies that both the added condition and the previous condition must be met to return results. Selecting **OR** signifies that either the added condition or the previous condition must be met to return results.
  - **Type** - Contains the sections of a rate calculator. The following radio buttons are available:
    - **Config** contains all fields found within the **Configuration** section of a rate calculator.
    - **Pricing** contains all fields found within the **Pricing** section of a rate calculator.
    - **Editing** contains all fields found within the **Editing** section of a rate calculator.
    - **Grouping** contains all fields found within the **Grouping** section of a rate calculator.
    - **Analyzing** contains all fields found within the **Analyzing** section of a rate calculator.
  - **Variable** - Contains all fields that will be included as part of the criteria based on selection from the **Type** radio button.
  - **Comparison** - Defines the relationship between the selected **Variable** and **Input**. The following drop-down options are available:
    - Does not equal
    - Equals
- Is greater than
- Is greater than or equal to
- Is less than
- Is less than or equal to

- **Input** - Contains a drop-down value or input field to compare against the selected **Variable**.

- **Pricer Type** - Contains a drop-down of all available Pricer types within that database only appears when the **Pricing** radio button is selected.

- **Selection** - Contains the following radio button options. Only appears when the **Pricing** radio button is selected:
  - **Variable** - When selected the **Input** field will contain all fields found within the **Pricing** section of the rate calculator for the selected **Pricer Type**.
  - **Value** - When selected the **Input** field will allow for a custom value.

- **Add Button** - Will add the criteria to the **Criteria Grid**.

- **Clear Button** - Will clear selected data in the **Criteria** panel.

Figure 3-7. Criteria Panel

- **Search** button - Will return to the **Home** screen and run a search using all of the criteria entered, and will display the results in the **Results** box on the **Home** screen.

- **Save** button - If a previously saved filter is selected, selecting **Save** will overwrite existing criteria with the new criteria. If this is a new filter, the **Create New Filter** screen will appear so the user can name the filter.
• **Save As** button - Will open the **Create New Filter** screen.

• **Delete** button - Will delete the saved filter name.

• **Cancel** button - Will close the **Advanced Filter Criteria** screen and return to the **Home** screen.

### 3.4 Multi-User Lock Functionality

Rate Manager supports a multi-user lock functionality which prevents users from editing a particular record when another user has the records locked for modification. The following screens have this functionality:

- **Rate Variable** screen (lock occurs at the pay source level)
- **ACE Override ID Editor** screen (lock occurs at the ACE Override ID level)
- **APC Grouper Editor** screen (lock occurs at the APC Override ID level)
- **ASC Grouper Editor** screen (lock occurs at the ASC Override ID level)
- **Fee Schedules** screen (lock occurs at the fee schedule level)
- **Extended Fee Schedule** screen (lock occurs at the extended fee schedule level)
- **Mapping Configuration Editor** screen (lock occurs at the Mapping Config Override ID level)
- **Physician Code Table** screen (lock occurs at the Physician Code Table level)

When any of these screens are locked by another user, a Lock Status Bar (shown in Figure 3-8) will appear on the top of the screen to notify you that it is locked for editing. The Lock Status Bar will identify the user who currently has the screen locked. Users with access greater than **read only**, will have the ability to unlock the record, making it available for modification, by selecting the **Unlock** button (shown in Figure 3-8).

**Note**

By unlocking a record, both users (the original user and the user who unlocked the record) will be able to save changes to the record. In that scenario, the user that commits a **Save** last, will overwrite any previous changes made by another user.
Figure 3-8. Example of Locked Status Bar and Unlock Button
4 Creating/Modifying Pay-Source & Rate Calculator Data

**Important**

In order to ensure regulatory compliance, Rate Manager populates all new fields and their corresponding default values for all existing rate records (i.e., Optum-supplied rates and custom rates). Please review custom rate data sets to ensure processing accuracy when new fields are added.

This chapter contains the following sections:

- Creating a New Pay-Source Record
- Creating a New Rate Calculator Record
- Modifying a Pay-Source & Rate Calculator Data
  - Modifying an Existing Pay-Source
  - Modifying Rate Calculator Data
- Procedure Based Rate Calculator(s)
- Enhanced New York Medicaid APG Pay-Sources
4.1 Creating a New Pay-Source Record

If the user has purchased Rate Manager database(s) from Optum, they do not need to set-up information for the pay-sources included in these database(s).

Identify pay-sources by creating pay-source records. All pay-source records are stored in the Rate Manager database(s).

To create a new record in Rate Manager, select the Create New button. The user will be advanced to the Rate Variable screen.

![Rate Variable Screen](image)

To create a new pay source record the user will need to fill out the information in the Configuration section of the Rate Variable screen.

1. In the Facility field enter the desired unique facility identifier. This field is alphanumeric and has a maximum of 16 characters.

2. In the NPI field enter the desired National Provider Identifier (NPI). This field is alphanumeric with a maximum of 10 characters.

**Note**

Users must enter either a Facility ID or NPI to continue.
3. In the **Taxonomy** field enter the desired taxonomy code. This field is alphanumeric with a maximum of 10 characters.

4. In the **Payer ID** field enter the desired unique payer identifier. This is a required field. This field is alphanumeric with a maximum of 9 characters when creating an NPI/Taxonomy paysource or a maximum of 13 characters when creating a Facility ID paysource.

5. In the **Name** field, enter the desired pay source name. This field is optional. This field is alphanumeric with a maximum of 25 characters.

6. In the **State/Abbr** field enter the state abbreviation (if applicable). This field is optional.

7. In the **Effective** field enter the desired effective date for the new pay source. The format of this field is mm/dd/yyyy.

8. In the **Pricer Type** field, select the desired Pricer Type to be utilized with the chosen effective date. In this drop-down the user will see all supported Pricer Types, not just the ones they license.

9. In the **Class** field, select the desired payment class (e.g., Medicaid, Medicare, Workers Compensation, etc.).

10. In the **Admit/Discharge Date** drop-down select the appropriate option for pricing. The correct option may appear as default. A = Admit Date, D = Discharge Date.

11. Select the **Do Not Export** check box to designate whether the pay source should not be exported.

12. Select the **Closed Facility** check box to designate whether the facility is closed/inactive.

**Note**
If a facility is marked as closed/inactive, you should utilize a different facility.

13. Once all of the required **Configuration** section fields have been completed, the new pay source will automatically be created, and the user will see additional fields appear under the **Editing**, **Grouping**, and **Pricing** sections on the **Rate Variable** screen.

To enter the remaining fields in the **Editing**, **Grouping**, **Pricing**, and **Weights/Rates** sections please refer to the applicable Rate Variables Worksheet (RVW). Optum houses a history of 1 year of RVWs on the [Optum Client Portal](https://www.optum.com) and/or the [Regulatory Portal](https://regulatoryportal.optum.com) at all times.

### 4.2 Creating a New Rate Calculator Record

A rate calculator record contains all of the hospital-specific information or variables needed to calculate reimbursement for a selected paysource at a specific point in time. A paysource can have multiple rate calculator records, each with a different effective date. This makes it possible to manage a
paysource’s pricing changes, while obtaining accurate reimbursement information for historical data. Patient admission or discharge dates (determined by the Admit/Discharge Date field) are checked against rate calculator effective dates, to determine which rates to apply to the patient’s visit. Rate calculator records are stored in the Rate Manager database.

Once all of the Rate Variable screen sections are filled in (Configuration, Editing, Grouping, Pricing, and Weights/Rates), select Save or Save and Close at the bottom of the screen. If you wish to cancel the rate calculator creation, select Cancel. You will then return to the Rate Manager Home/Main Screen.

Figure 4-2. Creating a New Rate Calculator Record

4.3 Modifying a Pay-Source & Rate Calculator Data

4.3.1 Modifying an Existing Pay-Source

You can modify an existing pay-source in Rate Manager by double-clicking a record from the Home page. You have the option of modifying the pay-source using the fields in the Configuration section (i.e., Name, State/Abbreviation, Export Queue, Effective Date, Class, Admit/Discharge Date, Do Not Export, and/or Closed Facility.) When one of these fields is changed, a tool-tip will appear indicating the field has been modified as shown below in Figure 4-3.

Once all configuration fields have been changed, you have the following options by selecting one of the buttons on the bottom right of the Rate Variable page as shown below in Figure 4-3:
• Save - to override the existing record and remain on the Rate Variable page
• Save and Close - to override the existing record and close the Rate Variable page and return to the Home page
• Save As - to create a new pay-source record with the modified changes. When selected, a Pay Source Pricer Save As dialog box will appear as shown below in Figure 4-4. To save a record designated with a Facility to an NPI, delete the value from the Facility field and click or tab away. The NPI and Taxonomy fields will become available for editing. In addition, the following check-boxes are available:
  - Include Shared Weight - When checked, a weight file previously shared to this paysource will be shared to the new paysource the user specifies in the configuration details. If this box is not checked, the new paysource will have no shared weights assigned to it.
  - Include All Effective Dates - When checked, all effective dates associated with the record's Facility and Payer ID will be copied to the user specified Facility and Payer ID. When this box is not checked, the date in the Effective field will be copied.
• Delete - to delete the existing pay-source
• Cancel - to cancel any changes and return to the Home page

Figure 4-3. Modifying a Pay-Source
4.3.2 Modifying Rate Calculator Data

You can modify rate calculator data for an existing pay-source in Rate Manager by double-clicking a record from the Home page. You can modify the rate calculator data using the fields within the Analyzing, Editing, Grouping, Pricing, and Weights/Rates sections. When one of these fields is changed, a tool-tip will appear indicating the field has been modified as shown below in Figure 4-5.

Once all Configuration fields have been changed, you have the following options by selecting one of the buttons on the bottom right of the Rate Variable:

- Save - to override the existing record and remain on the Rate Variable page
- Save and Close - to override the existing record and close the Rate Variable page and return to the Home page
- Save As - to create a new pay-source record with the modified changes. When selected, a Pay Source Pricer Save As dialog box will appear as shown above in Figure 4-4.
4.4 Procedure Based Rate Calculator(s)

In Rate Manager, there is an option to adjust certain rate calculators by utilizing the Procedure Editor. Clients would use this Editor to configure their rate calculator as either a different state or to deselect certain Medicaid procedures for the applicable rate calculator. This functionality is available by using the Medicaid APG Pro Pricer or the Medicaid APR Pro Pricer.

These Pricers were developed to support the payment methodology for multiple state Medicaid programs. Several state Medicaid programs utilize similar payment methodology. The procedures are state-specific and are derived from the State Rate Files. If clients choose not to use the state-specific rules, they can adjust the procedures in the Procedure Editor. To view the Procedure Editor:

1. Go to the Pricing section of Rate Manager (refer to Figure 4-6).
2. Within the Pricing section you will see State identifier (refer to Figure 4-6).
3. Select Other (refer to Figure 4-6).
4. Click Procedure Editor (refer to Figure 4-6).
5. The **Procedure Editor** screen will pop-up (refer to Figure 4-7).

The **Procedure Editor** screen contains two sections, **Procedures** and **Applied Procedures**. The **Procedure** section has four columns:

- **Procedures** - List of procedures
- **Procedure Description** - Brief description of the procedure
- **Associated Pricing Variables** - Pricing variable used with that procedure
- **Apply** - Shows which procedures are being applied

The **Applied Procedures** section will contain the list of procedures in the order you selected them from the **Procedures** section. You can adjust the order by clicking, holding, and moving the procedure to the position you wish.
6. Once completed, click **Save and Close** to save any changes you made and close the **Procedure Editor** or **Cancel** to close the **Procedure Editor** without saving.

### 4.5 Enhanced New York Medicaid APG Pay-Sources

In Rate Manager, there is an option to adjust locator and rate codes for base and capital rates utilizing the **Base and Capital Rates Editor**. This functionality is available by using the Enhanced New York Medicaid APG Pricer.

This Pricer was developed to facilitate the management of individual rates associated with specific clinic locations and rate codes. To view the **Base and Capital Rates Editor**:

1. Go to the **Weights/Rates** section on the **Rate Variable** page (refer to Figure 4-8).
2. Select the **Base and Capital Rates** button (refer to Figure 4-8).

**Note**

The **Base and Capital Rates** button only appears for an existing paysource. When creating a new paysource, you will need to save the new paysource first for the **Base and Capital Rates** button to appear.

---

3. The **Base and Capital Rates Editor** will pop-up (refer to Figure 4-9).
   - Double-click a record from the list to modify the effective date, base rate, and/or capital rate or delete the record,
   OR
   - Select the Add New button to add a new locator code, rate code, base rate, effective date, and capital rate.
4. The **Base and Capital Rates Editor Detail** will pop-up (refer to Figure 4-10).

Figure 4-10. Base and Capital Rates Editor Detail Pop-Up
5. Once completed, you have the following options by selecting one of the buttons on the bottom right of the **Base and Capital Rates Editor Detail** page as shown above in **Figure 4-10**:
   • Delete (to delete the existing record)
   • Save (to save any changes)
   • Cancel (to cancel any changes and return to previous screen)
Editors Menu

This chapter contains the following sections:
- Editors Overview
  - ACE Override ID
  - Contract APC
  - Contract ASC
  - Fee Schedule
  - Extended Fee Schedule
  - Mapping Config
  - Phys Code Table
  - Phys Pay Factor
5.1 Editors Overview

Within the Editors menu (shown below in Figure 5-1) the user will see the following options:

- **ACE Override ID**: User can add/edit/delete ACE Override ID(s) for a given record.
- **Contract APC** (shown if user licenses the APC Pro Payment System): User can modify procedure codes assigned to records.
- **Contract ASC** (shown if user licenses the ASC Pro Payment System): User can modify procedure codes assigned to records.
- **Fee Schedule**: User can add/edit/delete a specific Fee Schedule for a given record(s).
- **Extended Fee Schedule**: User can add/edit/delete a specific Extended Fee Schedule(s) for a given record(s).
- **Mapping Config**: Allows users to configure a Mapping Override File, as well as create a new Mapping Override File, which can be modified and exported.
- **Phys Code Table**: Allows users to modify existing Physician Code Table rules, as well as the ability to import Physician Code Table rules.
- **Phys Pay Factor**: Allows users to modify existing Physician Factor File rules, as well as the ability to import Physician Factor File rules.

Figure 5-1. Editors Menu
5.1.1 ACE Override ID

To open the ACE Override ID editor chose Editors > ACE OverrideID. Choosing this menu option will display the ACE Override ID Editor screen. This screen is broken down into two sections:

- **Filters** - Area in which the user enters the criteria to search for a particular ACE Override ID or create a new one.
- Override ID list - List area of all applicable ACE Override ID records based on the search criteria entered by the user.

Figure 5-2. ACE Override ID Editor Screen

5.1.1.1 Searching for an ACE Override ID

To search for a specific ACE Override ID, place the cursor in the Override ID text box under the Filters heading and select the Search button. If the ACE Override ID exists, it will be displayed in the Override ID section of the screen.

5.1.1.2 Creating an ACE Override ID

Rate Manager allows for the creation of a new ACE Override ID. To create a new ACE Override ID, select the Create New button. Selecting this button will open the Override ID Creation screen.
Enter the new ACE Override ID and select **Save**. The user will be brought back to the **ACE Override ID Editor** screen where the new ID is displayed.

### 5.1.1.3 Editing an ACE Override ID

To edit or modify an ACE Override ID, double-click on the ACE Override ID in the **ACE Override ID Editor** screen. This will open the **ACE Override ID Edit Creator** screen.
The following data will be displayed:

- The **Edit Num** (edit number)
- The **Edit Description**
- The edit application frequency:
  - **Always**: always apply edit
  - **Never Apply**: never apply edit
  - **Medicare**: apply according to Medicare rules

Select the **Save and Close** button when you are finished modifying or select **Cancel** to close the **ACE Override ID Edit Creator** screen.

**Note**

The user can also perform a search from the ACE Override ID Editor screen, via the **Edit Num**, **Edit Description**, and/or **Edit Flag** options under the **Filters** section.

### 5.1.1.4 Deleting an Existing ACE Override ID

To delete an ACE Override ID, select **Delete** when you have the ACE Override ID Edit Creator screen open. A prompt box will appear, confirming the ID to be deleted:
Figure 5-5. Delete Confirmation Box

![Delete Confirmation Box](attachment:image.png)

Click on **OK** and the ACE Override ID will be deleted, click **Cancel** and the ACE Override ID will remain as is.

5.1.2 Contract APC

**Note**
This utility is only available to clients that license the EASYGroup™ Contract APC Pricer and/or the APC Pro Payment System. For instructions on how to install the Contract APC utility within your Rate Manager application please refer to Rate Manager APC Pro and ASC Pro Installation chapter of the Rate Manager Installation Guide.

To open the **Contract APC** editor chose **Editors > Contract APC**. Selecting this option will display the **APC Grouper Editor** screen. This screen is broken down into two sections, as shown below.

- **Filters** - Area in which the user enters the criteria to search for a particular Override ID or create a new one.
- **Override ID** - List area of all applicable Override ID records based upon the search criteria entered by the user.
5.1.2.1 Searching for an Override ID
To search for a specific Override ID, place the cursor in the Override ID text box in the Filters section and select Search. If the Override ID exists it will be displayed on the screen.

Figure 5-7. Search Criteria Box

5.1.2.2 Modifying/Deleting HCPCS Codes in an Existing Override ID
In Rate Manager it is possible to modify or delete procedure codes associated with APC Grouper records. Within APC Grouper Editor screen, double-click on the Override ID line to be modified. This will open the APC Grouper Editor detail screen (refer to Figure 5-8). Within this screen, the user can double-click on the HCPCS they wish to modify/delete and the HCPCS Detail screen (refer to Figure 5-9) will appear.
The HCPCS Detail screen is split into two separate sections:

- **Modify HCPCS Rules** - contains the following fields detailing the procedure code assigned or to be assigned to an Override ID:
  - HCPCS (cannot be modified) (procedure code)
  - HCPCS Label (cannot be modified) (procedure code description)
  - APC (assigned APC)
  - Max Units (maximum units)
  - Start Date (effective date)
  - End Date
  - PayStat (Payment Status Indicator)

- **Medicare HCPCS Rules** - contains the list of values for the fields described above.

To modify an existing HCPCS code rule, enter the applicable information for the HCPCS code into the **Modify HCPCS Rules** section and select **Submit**. Once the Submit button has been selected, the HCPCS Detail screen will automatically close and the APC Grouper Editor screen will appear, with the procedure code record attached along with a message stating that the procedure code was added.
To delete a HCPCS code, select **Delete** from the **HCPCS Detail** screen (refer to **Figure 5-9**). The user will be prompted to confirm the deletion. The user can select **OK** to delete the HCPCS code. Once OK is selected, the **HCPCS Detail** screen will automatically close and the **APC Grouper Editor** detail screen will appear confirming the HCPCS code has been deleted.

**Figure 5-9. HCPCS Detail Screen**

5.1.2.3 Deleting an Existing Override ID

To delete an existing Override ID, double-click the Override ID you wish to delete within the **APC Grouper Editor** screen. The **APC Grouper Editor** detail screen will appear. Within the **APC Grouper Editor** detail screen, select **Delete** (refer to **Figure 5-10**). A prompt box confirming the deletion of the Override ID will appear. Select **OK** to continue with the Override ID deletion or select **Cancel**. All procedure codes that are associated to the particular Override ID will now be deleted (become unassigned to that Override ID).
5.1.2.4 Creating a Override ID
To create a new Override ID, the user can select Create New within the APC Grouper Editor screen (refer to Figure 5-11). The Override ID Creation screen will appear. The user can enter the desired Override ID name in the Override ID field and select Save. In the example below, the user has entered APCOverrideIDTest as an Override ID (refer to Figure 5-12).
Figure 5-11. Creating a New Override ID
Once **Save** is selected, the **Override ID Creation** screen will automatically close and the **APC Grouper Editor** screen will appear with the new Override ID in the **Override ID** column (refer to Figure 5-13).
5.1.2.5 Adding HCPCS Code Rules to an Override ID
To add new HCPCS code rules to an Override ID, the user can double-click on the Override ID they wish to add the HCPCS code rules to. In the example below the user is selecting to add HCPCS code rules to Override ID APCOverrideIDTest. Once the Override ID is selected, the APC Grouper Editor detail screen will appear. Select Create New HCPCS to add a new HCPCS code rule (refer to Figure 5-14).
Once the Create New HCPCS button is selected, the HCPCS Detail screen will appear. Enter the HCPCS code into the HCPCS field and press Tab on your keyboard. When the user tabs over, they will then see the current Medicare rules for the HCPCS code entered in the Medicare HCPCS Rules section. In the Modify HCPCS Rules section, the user can enter the information they wish to modify (Start date, End date, APC, PayStat, Max Units) and then select Submit.

In the example below (refer to Figure 5-15), the user wants to change HCPCS code D4283 to a APC Payment Status (PayStat) A and assign Maximum Units of Service (Max Units) of 1 with an effective date of January 01, 2018.
Once **Submit** is selected, the **HCPCS Detail** screen will automatically close and the **APC Grouper Editor** detail screen will appear with the added HCPCS code (refer to Figure 5-16). To add more HCPCS codes to the Override ID, follow these steps above or the user can select **Close** if they are finished adding HCPCS codes.
5.1.2.6 Exporting
The user may export to an APC Rule File (*apcrule.dat*) which will contain all the Override IDs along with the Override ID contents. To export, select **Export** within the **APC Grouper Editor** screen. The **APC Grouper Editor** screen will then show the status of the export process in the window next to the **Close** button. The APC Rule File (*apcrule.dat*) will be saved in the directory specified in the **Sys Admin > File Locations > Export** input path.
5.1.2.7 Importing
Users have the ability to import the data in their APC Rule File (apcrule.dat) as part of the standard import process (refer to Chapter 9, Utilities Menu). Override IDs along with the Override ID contents will be available for viewing, modification, and export in the APC Grouper Editor screen after successfully importing into Rate Manager.

5.1.2.8 Medicare Default Value Population On Export
Rate Manager includes functionality to populate the certain APC Rule File (apcrule.dat) fields (shown below in Table 5-1) with Medicare default values on export, only if those fields were imported with blank values. For fields where the default value logic isn’t applied, blank values will be retained on export and not populated with the Medicare default value.

Table 5-1: APC Rule File Fields That Populate Medicare Default Values

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Position</th>
<th>Format</th>
<th>Default Value Logic Applies?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Override ID</td>
<td>override_id</td>
<td>1 - 20</td>
<td>X(20)</td>
<td>No</td>
</tr>
<tr>
<td>Code Type</td>
<td>codetype</td>
<td>21</td>
<td>X(1)</td>
<td>No</td>
</tr>
<tr>
<td>HCPCS Code</td>
<td>code</td>
<td>22 - 30</td>
<td>X(9)</td>
<td>No</td>
</tr>
<tr>
<td>Code Sequence Number</td>
<td>codeseq</td>
<td>31 - 32</td>
<td>9(2)</td>
<td>No</td>
</tr>
<tr>
<td>Starting Date</td>
<td>startdate</td>
<td>33 - 40</td>
<td>9(8)</td>
<td>No</td>
</tr>
</tbody>
</table>
## Table 5-1: APC Rule File Fields That Populate Medicare Default Values

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Position</th>
<th>Format</th>
<th>Default Value Logic Applies?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ending Date</td>
<td>enddate</td>
<td>41 - 48</td>
<td>9(8)</td>
<td>No</td>
</tr>
<tr>
<td>Original Effective Date</td>
<td>origindate</td>
<td>49 - 56</td>
<td>9(8)</td>
<td>Yes</td>
</tr>
<tr>
<td>Further Qualifier Flag</td>
<td>furqual</td>
<td>57</td>
<td>9(1)</td>
<td>Yes</td>
</tr>
<tr>
<td>OCE Effective Version</td>
<td>ocevfrom</td>
<td>58 - 59</td>
<td>9(2)</td>
<td>Yes</td>
</tr>
<tr>
<td>OCE End Version</td>
<td>ocevthru</td>
<td>60 - 61</td>
<td>9(2)</td>
<td>Yes</td>
</tr>
<tr>
<td>Code Description</td>
<td>desc</td>
<td>62 - 85</td>
<td>X(24)</td>
<td>No</td>
</tr>
<tr>
<td>Sex Edit Indicator</td>
<td>sex</td>
<td>86</td>
<td>X(1)</td>
<td>No</td>
</tr>
<tr>
<td>Age Edit Indicator Diagnoses</td>
<td>age</td>
<td>87</td>
<td>X(1)</td>
<td>No</td>
</tr>
<tr>
<td>Minimum Age</td>
<td>minege</td>
<td>88 - 90</td>
<td>9(3)</td>
<td>Yes</td>
</tr>
<tr>
<td>Maximum Age</td>
<td>maxage</td>
<td>91 - 93</td>
<td>9(3)</td>
<td>Yes</td>
</tr>
<tr>
<td>CCI Control</td>
<td>ccicntl:</td>
<td>94</td>
<td>9(1)</td>
<td>Yes</td>
</tr>
<tr>
<td>OCE CCI Control</td>
<td>oceccicntl</td>
<td>95</td>
<td>9(1)</td>
<td>Yes</td>
</tr>
<tr>
<td>Procedure Category</td>
<td>nuq</td>
<td>96</td>
<td>X(1)</td>
<td>No</td>
</tr>
<tr>
<td>Bilateral Procedure Indicator</td>
<td>bilatop</td>
<td>97</td>
<td>9(1)</td>
<td>Yes</td>
</tr>
<tr>
<td>APC</td>
<td>apc</td>
<td>98 - 102</td>
<td>9(5)</td>
<td>Yes</td>
</tr>
<tr>
<td>APC Payment Status</td>
<td>hpaystat</td>
<td>103 - 104</td>
<td>X(2)</td>
<td>Yes</td>
</tr>
<tr>
<td>Reserved</td>
<td></td>
<td>105</td>
<td>X(1)</td>
<td>N/A</td>
</tr>
<tr>
<td>Maximum Units of Service</td>
<td>units</td>
<td>106 - 112</td>
<td>9(7)</td>
<td>Yes</td>
</tr>
<tr>
<td>Utility Date</td>
<td>apcdate</td>
<td>113 - 120</td>
<td>9(8)</td>
<td>Yes</td>
</tr>
<tr>
<td>Utility Rate</td>
<td>apcrate</td>
<td>121 - 130</td>
<td>9(8)v9(2)</td>
<td>Yes</td>
</tr>
<tr>
<td>Utility Date2</td>
<td>apcdate2</td>
<td>131 - 138</td>
<td>9(8)</td>
<td>Yes</td>
</tr>
<tr>
<td>Approval Date Edit Number</td>
<td>dateeditno1</td>
<td>139 - 140</td>
<td>9(2)</td>
<td>Yes</td>
</tr>
<tr>
<td>Filler</td>
<td></td>
<td>141 - 159</td>
<td>X(19)</td>
<td>No</td>
</tr>
<tr>
<td>Approval Date Edit Number 2</td>
<td>dateeditno2</td>
<td>160 - 162</td>
<td>9(3)</td>
<td>Yes</td>
</tr>
<tr>
<td>Filler</td>
<td></td>
<td>163 - 167</td>
<td>X(5)</td>
<td>No</td>
</tr>
<tr>
<td>OCE Code Category</td>
<td>ocecat</td>
<td>168 - 170</td>
<td>9(3)</td>
<td>Yes</td>
</tr>
<tr>
<td>OCE Switch 1 - 30</td>
<td>ocesw1</td>
<td>171 - 200</td>
<td>9(30)</td>
<td>Yes</td>
</tr>
<tr>
<td>Physician/ASC Units of Service</td>
<td>physunits</td>
<td>201 - 207</td>
<td>9(7)</td>
<td>Yes</td>
</tr>
<tr>
<td>Reserved</td>
<td></td>
<td>208 - 220</td>
<td>X(13)</td>
<td>No</td>
</tr>
</tbody>
</table>
5.1.3 Contract ASC

Note
This utility is only available to clients that license the EASYGroup™ Contract ASC Pricer and/or the ASC Pro Payment System. For instructions on how to install the Contract ASC utility within your Rate Manager application please refer to Rate Manager APC Pro and ASC Pro Installation chapter of the Rate Manager Installation Guide.

To open the Contract ASC editor chose Editors > Contract ASC. Selecting this option will display the ASC Grouper Editor screen. This screen is broken down into two sections, as shown below.

- Filters - Area in which the user enters the criteria to search for a particular Override ID or create a new one.
- Override ID - List of all applicable Override ID records based on the search criteria entered by the user.

Figure 5-18. ASC Grouper Editor Screen

5.1.3.1 Searching for an Override ID
To search for a specific Override ID, place the cursor within the Override ID text box in the Filters section and select on the Search button.
5.1.3.2 Modifying an Override ID
Within Rate Manager it is possible to add/change/delete procedure codes associated with ASC Grouper records. To modify an Override ID, double-click the Override ID you wish to modify within the ASC Grouper Editor screen. This will prompt the ASC Grouper Editor detail screen to open. In the ASC Grouper Editor detail screen, you can add/change/delete procedure codes associated with ASC Grouper records.

5.1.3.3 Modify HCPCS Rules
To modify a procedure code associated with ASC Grouper record, double-click the procedure code from the list in the ASC Grouper Editor detail screen. This will prompt the HCPCS Detail screen to open. The HCPCS Detail screen is split into two separate sections:

- **Modify HCPCS Rules** - contains the following fields detailing the procedure code assigned or to be assigned to an Override ID:
  - HCPCS (cannot be updated) (procedure code)
  - APC (APC assigned)
  - Pay Stat (Payment Status Indicator)
  - Start Date (effective date)
  - End Date
  - Cov

- **Medicare HCPCS Rules** - contains a list of values for the fields described above.
Enter the applicable information for the procedure code and select **Submit**. If the procedure code record to be attached does not need to be updated by the user select **Submit** without making any changes.

Once the **Submit** button has been selected, the **ASC Grouper Editor** screen will be displayed, with the procedure code record attached along with a message stating that the procedure code was added.

### 5.1.3.4 Deleting an Existing Override ID

To delete an existing Override ID, double-click the Override ID you wish to delete from the ASC Grouper Editor screen. In the ASC Grouper Editor detail screen, select **Delete**. By selecting the **Delete** button, all procedure codes that are associated with the particular Override ID will be deleted (become unassigned to that Override ID). A prompt box confirming the deletion of the Override ID will appear. Select **OK** to continue with the Override ID deletion or select **Cancel**.

### 5.1.3.5 Delete an Existing Procedure Code

Within the **HCPCS Detail** screen, highlight the procedure code line that is to be deleted and select the **Delete** button. A prompt box will appear confirming the deletion. Select **OK** to delete the procedure code or select the **Cancel** button. The **ASC Grouper Editor** screen will be displayed along with a message stating that the deletion was successful.
5.1.4 Fee Schedule

To open the Fee Schedule editor chose Editors > Fee Schedule. The Fee Schedule editor allows for the addition and modification of records to a specified table, by procedure code, fee schedule type, and location/carrier. The Fee Schedules screen is broken down into multiple columns, as shown below in Figure 5-21:

- Fee Schedules (displays list of Optum supplied Fee Schedules)
- Pricer Type (displays the Pricer Type)
- Custom Fee Schedules (displays list of Custom Fee Schedules)
- Status (displays if file is locked by another user)
- Action (displays if file was User Imported or User Created)
- Action Date (displays when file was imported or created/modified)

To display a Fee Schedule on the Fee Schedule editor list the following criteria must be met:

1. File is saved in the directory specified in the Sys Admin>File Locations>Fee + Extended Fee Schedules input path.
2. Fee Schedule name is prefaced with an FS or FEE (ex: fstest.dat or feetest.dat).
3. Fee Schedule conforms to the fixed width file format outlined in the Technical Reference Guide> Fee Schedule File Layouts chapter included with your Rate Manager installation.

Or

Fee Schedule conforms to the custom file comma delimited format outlined in the Technical Reference Guide> Fee Schedule File Layouts chapter included with your Rate Manager installation.
To view a specific Fee Schedule file highlight the Fee Schedule in the Fee Schedules screen and double-click. This will display the Fee Schedule Editor screen.
5.1.4.1 Searching for a Record Within a Fee Schedule
The Fee Schedule editor contains a search function which permits the user to locate a particular record within a Fee Schedule.

Figure 5-23. Search for a Record Within a Fee Schedule

To search for a particular record, enter a HCPCS (procedure code), Fee Schedule Type, or Location/Carrier, or any combination of the three and select Search. The results of the search will be appear in the Fee Schedules screen. To remove the results select Clear and the contents of the search will be erased.

5.1.4.2 Viewing a Record Within a Fee Schedule
The Fee Schedule Editor Screen displays all records within a particular Fee Schedule, or the results of a particular search for a record within a Fee
To view additional information on a particular record within a Fee Schedule, double-click on the record displayed. The Fee schedule Editor Detail screen will appear.

Figure 5-24. Fee Schedule Editor Detail Screen

Note
Modifications cannot be made to a particular record within this screen. To make modifications to a Fee Schedule the user must Create a Custom Fee Schedule File.

5.1.4.3 Create a Custom Fee Schedule File
Creating a custom fee schedule file allows the user to modify an existing Fee Schedule. For this purpose, Rate Manager has the option to create a custom fee schedule file. Within the Fee Schedule Editor screen, select the Create Custom Fee Schedule button.

This will display the Create Custom Fee Schedule screen (shown below in Figure 5-25). There are two fields within this screen:

- **Original Fee Schedule File Name.** Name of the Fee Schedule you wish to copy.
- **New Custom Fee Schedule File Name.** Name of the custom fee schedule file to be created.
Enter the desired name of the custom fee schedule file and select **Save**. Once the custom fee schedule file has been created and saved successfully, the user will be redirected to the **Fee Schedule Editor** screen.
5.1.4.4 Creating New HCPCS Code Within a Custom Fee Schedule

To add a new code to the custom Fee Schedule, select Add New HCPCS Code button (refer to Figure 5-27) within the Fee Schedule Editor screen to have the Create New HCPCS window appear (refer to Figure 5-28).
Figure 5-27. Add New HCPCS Code Button
The user can now add HCPCS codes based on the following key fields listed below along with the pricer specific fields and apply them to the custom Fee Schedule file:

- **HCPCS (procedure codes)**
- **Location/Carrier**
- **Start Date**
- **End Date**
- **Modifier 1 - 5**
- **Fee Schedule Type**
- **Gap Fill Indicator**
- **Rate 1 - 5**
- **Multiple Fee Schedule Types Flag**

Once all information has been entered, click the Save button to add the new HCPCS code to the custom Fee Schedule file and the user will be returned to the Fee Schedule Editor screen. The user will see a note indicating that the HCPCS code was saved successfully.

### 5.1.4.5 Modifying Records Within a Custom Fee Schedule

To modify a particular record locate and double-click on the record to be modified. The Fee Schedule Editor Detail screen will appear.
The user can now make modifications to any of the following fields and apply them to the custom fee schedule file:

- HCPCS (procedure codes; this field cannot be modified)
- Location/Carrier
- Start Date
- End Date
- Modifiers 1 - 5
- Fee Schedule Type
- Gap Fill Indicator
- Rate 1 - 4
- Multiple Fee Schedule Types Flag

For example, if a user would like to change the Fee Schedule (FS) Type to a value of A. Enter an A within the FS Type box and select Save.

Figure 5-29. Fee Schedule Editor Detail Screen

Once the Save button is selected, the Create Custom Rate File screen will automatically close and the Fee Schedule Editor screen re-appears. The change to the record that was made now appears.

5.1.4.6 Exporting a Custom Fee Schedule File
Once the user has created a custom Fee Schedule file, the user can export the file. To export, click the Export button within the Fee Schedule Editor
screen. The Fee Schedule Editor screen will show the status of the export process in the Export Status Window next to the Create Custom Fee Schedule button. The custom Fee Schedule file is saved in the directory specified in the Sys Admin > File Locations > Export input path.

5.1.5 Extended Fee Schedule

To open the Extended Fee Schedule editor chose Editors > Extended Fee Schedule. The Extended Fee Schedule option allows for the attachment of an Extended Fee Schedule to a particular record by the Pricer Type. The Extended Fee Schedule screen is broken down into multiple columns, as shown below in Figure 5-30:

- Extended Fee Schedules (displays list of Optum supplied Extended Fee Schedules)
- Pricer Type (displays the Pricer Type)
- Custom Extended Fee Schedules (displays list of Custom Extended Fee Schedules)
- Status (displays if file is locked by another user)
- Action (displays if file was User Imported or User Created)
- Action Date (displays when file was imported or created/modified)

Figure 5-30. Extended Fee Schedule Screen
5.1.5.1 Searching for an Extended Fee Schedule
To the left of the Extended Fee Schedule screen is the Extended Fee Schedule search box where the user can enter a file name or part of a file name.

Figure 5-31. Search for an Extended Fee Schedule

The result of the search will be shown in the Extended Fee Schedule screen.

**Note**
Each Extended Fee Schedule File is associated with a Pricer Type.

5.1.5.2 Viewing an Extended Fee Schedule
To view the contents of an Extended Fee Schedule File, double-click on the name of the Extended Fee Schedule. The Extended Fee Schedule Editor screen will appear.
5.1.5.3 Viewing a Record within an Extended Fee Schedule

To view a record within an Extended Fee Schedule double-click the record within the Extended Fee Schedule Editor screen. The Extended Fee Schedule Editor Detail screen will appear.
Use the scroll bar at the right side of the screen to view additional fields for the record. The fields within each Extended Fee Schedule depend upon the type of classification (Pricer Type).

5.1.5.4 Create a Custom Extended Fee Schedule File
Creating a custom Extended Fee Schedule file allows the user to modify an existing Extended Fee Schedule. For this purpose, Rate Manager has the option to create a custom Extended Fee Schedule file. To create a custom extended fee schedule file, select Create Custom Fee Schedule button within the Extended Fee Schedule Editor screen.

This will display the Create Custom Extended Fee Schedule screen (shown below in Figure 5-34). There are two fields within this screen:

- **Original Extended Fee Schedule File Name** (Name of the Extended Fee Schedule you wish to copy)
- **New Custom Extended Fee Schedule File Name** (Name of the custom Extended Fee Schedule file to be created)
Enter the desired name of the custom Extended Fee Schedule file and select **Save**. Once the custom Extended Fee Schedule file has been created and saved successfully, the user will be redirected to the **Extended Fee Schedule Editor** screen.
5.1.5.5 Creating New HCPCS Code Within a Custom Extended Fee Schedule

The user can add HCPCS codes based on the fields available to the Pricer Type in use and apply them to the custom Extended Fee Schedule file. In the examples below, the user has chosen to modify a custom Extended Fee Schedule with Pricer Type Medicare APC.

To add a new code to the custom Extended Fee Schedule, select Add New HCPCS Code (refer to Figure 5-36) within the Extended Fee Schedule Editor screen to have the Extended Fee Schedule Editor Detail screen appear (refer to Figure 5-37).

In the example below, the user is adding HCPCS code D4283 with a Reduced Therapy Rate of 70.44 and a Non-Facility PE RVU of 0.88000, effective April 01, 2016.
Figure 5-36. Add New HCPCS Code Button

Figure 5-37. Extended Fee Schedule Editor Detail Screen
Note
The fields available will differ depending on the Pricer Type of the custom Extended Fee Schedule.

Once all information has been entered, select **Save** to add the new HCPCS code to the custom Extended Fee Schedule file and the user will be returned to the **Extended Fee Schedule Editor** screen. The user will see a note indicating that the HCPCS code was saved successfully.

5.1.5.6 Modifying Records With a Custom Extended Fee Schedule
Users can modify existing records within a Custom Extended Fee Schedule file. To modify a record, the user would double-click on the record they wish to modify. The **Extended Fee Schedule Editor Detail** screen will then appear (refer to Figure 5-38).

The user can now make modifications to the available fields and apply them to the custom Extended Fee Schedule File. In the example above (refer to Figure 5-38), the user is changing the Reduced Therapy Rate to 60.44 for HCPCS code 92506.

Figure 5-38. Extended Fee Schedule Editor Detail Screen

Once all modifications have been completed, select **Save**. The **Extended Fee Schedule Editor Detail** screen will automatically close and the **Extended Fee Schedule Editor** screen re-appears with a note confirming the updated was successfully saved.
5.1.5.7 Exporting a Custom Extended Fee Schedule File
Once the user has created a custom Extended Fee Schedule file, the user can export the file. To export, select **Export** within the **Extended Fee Schedule Editor** screen. The **Extended Fee Schedule Editor** screen will then show the status of the export process in the window next to the **Delete** button. The custom Extended Fee Schedule file is saved in the directory specified in the **Sys Admin>File Locations>Export** input path.

5.1.6 Mapping Config
To open the **Mapping Config** editor chose **Editors>Mapping Config**. This editor allows users to configure a Mapping Override File, as well as to create a new Mapping Override File which can be modified and exported. The file that is generated by this utility is the Mapping Override File (maprule.dat).

1. Click the **Create New** button to create a new Override ID. Once a new ID is created, it will be displayed on the **Mapping Configuration Editor** screen. Selecting **Create New** will open the **Override ID Creation** screen.
2. Enter an Override ID in the **Override ID** field.
3. Click **Save**.
4. You should now see the new Override ID on the **Mapping Configuration Editor** screen. To edit this Override ID, double-click it on the screen. You will now see the Mapping Configuration Editor screen.
5. Select the **Create New DX/PX Code** button to open the **DX/PX Code Details** screen.
Note
Once in the **DX/PX Code Details** screen, the user now has the ability to modify the mapping rules for a specific diagnosis or procedure code.

Under the **Modify Mapping Rules** section you will see the following options:

- **Form Code**:
  - This field is the ICD-9 or ICD-10 diagnosis or procedure code.

- **Code Type**:
  - The applicable Code Type (D = Diagnosis) or (P = Procedure) must be chosen in this field.

- **Form Version**:
  - Choose the appropriate version to map the code to a target version (e.g., V28 = effective October 1, 2010).

- **Map Type**:
  - Type of mapping to be selected: 01 = CMS Reimbursement, 02 = Optum Premier Pick, 03 - 99 = State-specific or custom mapping.

- **Map Direction**:
  - This field is used to set the Mapping direction (forward or backward).
• To Version:
  - Choose the appropriate version to map the code from a target version (e.g., V28 = effective October 1, 2010).

• Number Target:
  - This field is filled in based on the total number of codes entered (if Code1 - Code4 are data filled, then Number Target will display a 4).

• Code1 - Code10:
  - These are the ICD-9 and ICD-10 diagnosis or procedure codes being mapped to.

Once the mapping modification is complete, the rules will be displayed on the Mapping Configuration Editor screen.

6. Double-click on the desired line to modify or delete any of the mapping rules. The DX/PX Code Details screen will appear.

Users can change any of the codes (Code1 - Code10) or delete an entire Override ID on this screen. By clicking the Delete button mapping rules can also be deleted.

7. Click the Export button once the desired mapping configuration is created. This will allow the user to export any of the mapping rule files listed on the Mapping Configuration Editor screen.
5.1.7 Phys Code Table

To open the Physician Code Table editor choose Editors > Phys Code Table. The Physician Code Table editor allows users to modify existing Physician Code Table rules, as well as the ability to import Physician Code Table rules. In order to modify an existing Physician Code Table file (codephys.dat) and implement the modifications, you must complete the following steps:

1. Import an existing Physician Code Table File into the Rate Manager application. For further information on importing please refer to the Utilities Menu chapter of this guide.

2. Save any modifications to the Physician Code Table File following the steps as described below.

3. Perform an export via the Rate Manager application. For further information on exporting please refer to the Utilities Menu chapter of this guide.

4. Move the exported Physician Code Table File from the Export directory into the FeeScheduleFiles directory.

**Note**

For further information on the Physician Code Table File layout please refer to the Rate Manager Technical Reference Guide.

Figure 5-43. Physician Code Table Screen
5.1.7.1 Filtering
Within the Physician Code Table screen, you can filter the data to narrow down your search. The Filters panel is located on the left side of the screen.

Figure 5-44. Filters Panel

You can filter by the Code Type and/or Code. To perform a search:

1. Select/enter your criteria using the Code Type drop-down and/or the Code text box.

2. Once you have entered your criteria, select the Search button to perform a search. Your results will appear in the results panel as shown below in Figure 5-45. Select the Clear button to clear any criteria.

Figure 5-45. Filtering Example
5.1.7.2 Modifying/Deleting an Existing Code
To modify/delete an existing code:

1. Double-click the code in the results panel.

2. The Physician Code Table Detail dialog box will appear with the current details for this code in the Physician Code Table.

Figure 5-46. Physician Code Table Detail Dialog Box

3. After making modifications to the applicable fields, select the Save and Close button to save your changes and close the dialog box. Select Delete to delete the code or Cancel to close the dialog box without saving any changes.
5.1.7.3 Adding a New Code

To add a new code:

1. Select the **Create New Code** button located in the top left side of the **Physician Code Table** screen.

![Create New Code Button](image)

Figure 5-47. Create New Code Button

2. The **Physician Code Table Detail** dialog box will appear. Select a Code Type from the drop-down, then enter the Code in the text box. Enter any other desired details in the applicable text boxes. Once done, select the **Save and Close** button to save your changes and close the dialog box. Select **Cancel** to close the dialog box without saving any changes.
Figure 5-48. New Entered Code Example
5.1.8 Phys Pay Factor

To open the **Physician Payment Factor** screen choose **Editors > Phys Pay Factor**. The **Physician Payment Factor** screen displays all the Physician Factor Files (*facphyyy.dat*) located in the FeeScheduleFiles directory and database (custom files only) (shown in Figure 5-49). To edit a Physician Payment Factor file, double-click the file in results panel to open the **Physician Payment Factor Editor** screen (shown in Figure 5-50). The Physician Payment Factor Editor allows for the addition and modification of records to a specified table, by billing National Provider Identifier (NPI), Paysource, and Tax Identification Number (TIN).

**Note**

For further information on the Physician Factor File layout please refer to the Rate Manager Technical Reference Guide.

Figure 5-49. Physician Payment Factor Screen
5.1.8.1 Filtering
Filtering is available in both the Physician Payment Factor screen and Physician Payment Factor Editor screen. The filtering options are located on the left side of the applicable screen.

- Filtering on the Physician Payment Factor screen

In the Physician Payment Factor screen, you can filter by file name to narrow down your search. The Filters panel is located on the left side of the Physician Payment Factor screen.

Figure 5-51. Physician Payment Factor Filters Panel

You can filter by the Physician Payment Factor File name. To perform a search:

1. Enter your criteria using the Physician Payment Factor File text box.
2. Once you have entered your criteria, select the **Search** button to perform a search. You results will appear in the results panel as shown below in Figure 5-52. Select the **Clear** button to clear any criteria.

Figure 5-52. Filtering Example

- Filtering on the Physician Payment Factor Editor screen

In the **Physician Payment Factor Editor** screen, you can filter by **NPI**, **Pay Source**, and/or **TIN** to narrow down your search. The **Filters** panel is located on the left side of the **Physician Payment Factor Editor** screen.
Figure 5-53. Physician Payment Factor Editor Filters Panel

To perform a search for a specific record:

1. Enter the **NPI**, **Pay Source**, and/or **TIN** in the applicable text box.
2. Select the **Search** button to perform the search. Select **Clear** to clear the search results.

Figure 5-54. Physician Payment Factor Editor Search Example
5.1.8.2 Create a Custom Physician Payment Factor File

Creating a custom Physician Payment Factor File allows you to modify an existing Physician Payment Factor File. To create a custom Physician Payment Factor File:

1. Select the **Create Custom Physician Payment Factor File** button at the bottom right side of the **Physician Payment Factor Editor** screen (shown below in **Figure 5-55**).

Figure 5-55. Create Custom Physician Payment Factor File Button

2. The **Create Custom Physician Payment Factor File** dialog box will appear. Enter the desired custom file name in the **New Custom Physician Payment Factor File Name** text box. Select the **Save** button to save the custom file name and close the dialog box. Select the **Cancel** button to close the dialog box without saving any changes.

**Note**

The file name must be prefixed with `fac`. 
3. You can either modify/delete the payment factor for an existing NPI, Paysource, and TIN or add a new payment factor for an NPI, Paysource, and TIN. To modify/delete, double-click the record from the results panel. To add, select the **Add New Phys Payment Factor** button at the top left side of the **Physician Payment Factor Editor** screen (shown below in Figure 5-57). Either of these actions will open the **Physician Payment Factor Editor Details** dialog box.
4. Modify or add any details you desire in the **Physician Payment Factor Editor Details** dialog box (shown below in Figure 5-58). Select the **Save** button to save any changes/additions and close the dialog box. Select **Cancel** to close the dialog box without saving any changes/additions. Select the **Delete** button to delete an existing record and close the dialog box.

**Note**
The **Delete** button is only visible for existing/saved records.
5.1.8.3 Exporting a Custom Physician Payment Factor File
You can export a custom Physician Payment Factor File. The Export button is located on the bottom right side of the Physician Payment Factor Editor screen. When selected, the exporting processing will begin and the status will appear on the bottom left side of the screen (shown below in Figure 5-59).
5.1.8.4 Deleting a Custom Physician Payment Factor File

You can delete a custom Physician Payment Factor File. The Delete button is located on the bottom right side of the Physician Payment Factor Editor screen (shown below in Figure 5-60). When selected, the a delete confirmation dialog box will appear (shown below in Figure 5-61). Select the OK button to delete the Physician Payment Factor File. Select the Cancel button close the dialog box without deleting the Physician Payment Factor File.
Figure 5-60. Custom Physician Payment Factor File Delete Button

Figure 5-61. Delete Confirmation Dialog Box
6 Global Edit Menu

This chapter contains the following sections:

- Global Edit Overview
  - Edit All
  - Copy/Delete
  - Do Not Export
  - Export Queue
6.1 Global Edit Overview

Within the Global Edit menu the user will see the following options:

- **Edit All:** Allows a mass update of data within the Rate Manager database. Users may create multiple target configurations by utilizing the Facility, NPI, Taxonomy, Payer ID, Grouper, Grouper Version, and effective dates. All rate records within the Rate Manager database that meet the requirements of the target configuration(s), would be edited based on the information entered in the Configuration Detail section of Edit All. The field values available for editing are driven by the Pricer Type selected.

- **Copy/Delete:** Allows the user to copy or delete all pay-source(s) and pay-source information.

- **Do Not Export:** Records with this distinction will not export when an export is invoked by the user.

- **Export Queue:** Records with this distinction will be added to a queue of facilities that can be exported to on their own when the Export Queue option is selected from the Export page.

6.1.1 Edit All

To open the Edit All menu choose Global Edit>Edit All. You will now see the Edit All screen:
In this screen, choose the appropriate **Pricer Type**. At this time, the **Edit All** screen will display the appropriate values associated with the Pricer Type selected. Enter the **Facility**, **NPI**, **Taxonomy**, **Payer ID**, **Grouper type**, **Grouper Version**, **From Effective Date**, and/or **To Effective Date** and click the **Add** button to add the **Configuration Detail** to the **Configuration box**. The user may also delete that configuration in the **Configuration box** by clicking the **Delete** button on the configuration line. Users have the ability to enter multiple target configurations to apply the change detail to. The user will have the option to choose a Grouper type and version to edit. Scroll down to view all available fields that can be updated. You should see something similar to the below example screen. In this example a **Payer ID** of **09** and the **Pricer Type** of **Medicare (CMS)** was used as a target.
Figure 6-2. Edit All Screen Example

Note
The Change Detail is driven based on the Pricer Type selected. Refer to the latest applicable Rate Variables Worksheet (RVW); located in the Help -> References menu, for further information on the different variables listed.

Adjust any variables on the screen that you desire and select Submit. You should see the below message at the bottom of the screen if the record was updated successfully. Select Clear All to clear all input in the Edit All screen. Select Close to go back to the Rate Manager Main/Home screen without saving any changes.

6.1.2 Copy/Delete
To open the Copy/Delete menu choose Global Edit>Copy/Delete. The Copy/Delete Pay-Sources screen will be displayed as shown below in Figure 6-3.
Important
Please note that this process should be completed with great care. The copy/delete function is irreversible.

Below you will find step-by-step instructions on how to use the Copy function. The results will vary depending on the fields populated. Table 6-1 illustrates the different Copy functionalities that are supported and their results. The “X” identifies the fields required to be populated in order to receive the results as described.

To Copy:

1. Select Copy at the top of the screen.
2. In the Copy From section, enter the Payer ID you wish to copy from in the Payer ID field.
3. Select the appropriate Payer/Pricer Type (required) from the dropdown.
4. Enter the desired Effective Date.
5. In the Copy To section, enter the Payer ID you wish to copy to in the Payer ID field.
6. Enter the desired Effective Date.
7. The Rate Calculators Copied/Deleted field will display the copy/delete results.

8. Select Submit to process the copy function or select Close to go back to the Rate Manager Main/Home screen without saving the changes.

9. If you selected Submit, the logging process will show in the logging section (as shown in Figure 6-3) and once completed you can now view the new pay-source record on the Search screen.

Table 6-1: Copy Functionality

<table>
<thead>
<tr>
<th>Copy From:</th>
<th>Copy To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payer ID</td>
<td>Payer/Type</td>
</tr>
<tr>
<td>X X</td>
<td>X</td>
</tr>
<tr>
<td>X X</td>
<td>X</td>
</tr>
<tr>
<td>X X</td>
<td>X</td>
</tr>
<tr>
<td>X X</td>
<td>X</td>
</tr>
</tbody>
</table>

To Delete:

1. Select Delete at the top of the screen.

2. In the All Pay-Sources with Payer ID field enter the Payer ID you wish to copy/delete.

3. Select the appropriate Payer/Pricer Type from the drop-down.

4. Enter the desired Effective Date.

5. Select Submit to process the delete function or select Close to go back to the Rate Manager Main/Home screen without saving the changes.

6. If you selected Submit, the logging process will show in the logging section (as shown in Figure 6-4).
6.1.3 Do Not Export

To open the Do Not Export menu choose Global Edit>Do Not Export. You should see the Do Not Export screen:
In this screen users may configure a Do Not Export hold on any of the following items:

- Facility (facility identifier)
- NPI (National Provider Identifier (NPI))
- Taxonomy (taxonomy code)
- Payer ID
- From Effective Date
- To Effective Date
- Pricer Type

One or any combination of the items listed above can be used to drill down the Do Not Export function to locate the desired rate record(s). In order to set the records to a Do Not Export state, the Do Not Export checkbox must be selected.

6.1.3.1 Adding/Removing Records from Do Not Export

Once the criteria is entered and the Submit button is selected, an Updating status will appear. After the update has completed the Record set to Do Not Export field will populate with the number of records set to Do Not Export.

In order to remove the Do Not Export from rate records the user must select the criteria that is set to Do Not Export and un-check the Do Not Export check
Once the Submit button is selected the Do Not Export will be removed from the record.

**Note**

If users wish to view which records are set to Do Not Export, a report can be run (Reports>All Pay Sources Report).

**Important**

Global Edit - Do Not Export uses a search based on the information provided. For example, entering Facility 999 and clicking submit will add all records that contain a 999 in the Facility (including facility 0999 or 999A, etc.).

### 6.1.4 Export Queue

To open the Export Queue menu choose Global Edit > Export Queue. You should see the Global Edit Export Queue screen:

![Global Edit Export Queue Screen](image)

In this screen users may add records to the Export Queue in bulk utilizing the following criteria:

- Facility (Facility Identifier)
- NPI (National Provider Identifier)
- Taxonomy (Taxonomy Code)
• Payer ID

One or any combination of the items listed above can be used to narrow down the Export Queue function to locate the desired records. In order to add the records to the Export Queue, the Export Queue check box must be selected.

6.1.4.1 Adding/Removing Records from the Export Queue

Once the criteria is entered and the Submit button is selected, an Updating status will appear. After the update has completed the Records set to Export Queue field will populate with the number of records added to the Export Queue.

In order to remove the Export Queue setting from rate records the user must select the criteria that is set to Export Queue and un-check the Export Queue check box. Once the Submit button is selected the Export Queue will be removed from the record.

The Export Queue is maintained at a facility level. Adding an individual rate calculator for a facility to the Export Queue will add all effective dates for that facility to the Export Queue.

Note

When adding a facility to the Export Queue if an individual rate calculator shares weights with another facility, that shared facility will also be automatically included as part of the Export. This is to allow for a fully functioning set of rates.

Global Edit - Export Queue uses a search based on the information provided. For example, entering a facility 999 and clicking submit will add all records that contain a 999 in the facility (including facility 0999 or 999A, etc.).
7 Reports Menu

This chapter provides descriptions and samples of the reports available in Rate Manager. Each description consists of a brief summary of the report’s purpose, followed by a detailed listing of the report’s contents. A sample report follows each description.

This chapter contains the following sections:

- Reports Overview
  - Audit Trail Report
  - All Pay Sources Report
  - Pricer Type Details Report
7.1 Reports Overview

Within the Reports menu the user will see the following options:

- Audit Trail
- All Pay Sources
- Pricer Type Details

7.1.1 Audit Trail Report

To run the Audit Trail report navigate to Reports>Audit Trail. The Audit Trail report can be used for tracking and error investigation.

Figure 7-1. Audit Trail Report

The Audit Trail screen is split into three sections:

- **Audit Selection**: The available selections are:
  - Rates (Contains audit information regarding changes made within pay sources and rate calculators)
  - Editors (Contains audit information regarding changes made within the Editors menu)
  - Sys Admin (Contains audit information regarding changes made within the Sys Admin menu)
  - Archive (Contains audit information regarding changes made the Archive option within the Utilities menu (Rate Manager Pro only))
• **Audit**: The available fields in which the search for the Audit Trail can be performed
  - when **Rates** is selected:
    - Facility (facility identifier)
    - NPI (National Provider Identifier (NPI))
    - Taxonomy (taxonomy code)
    - Payer ID (unique payer identifier)
    - Pricer (Pricer type)
    - Effective (effective date)
    - User ID (contains all User IDs identified in the database)
    - From Date (input field with available calendar to select date)
    - To Date (input field with available calendar to select date)
    - Old Value (the value of the field prior to the change)
    - New Value (the value of the field after the change)
    - Import
    - UI
    - Field/Table (applicable field name)
    - Pricing (contains a list of all available pricing variables when a Pricer is selected)
    - Editing (contains a list of all available editing variables)
    - Grouping (contains a list of all available grouping variables)
  - when **Editors** is selected:
    - User ID (contains all User IDs identified in the database)
    - Menu
    - Field (available selections vary based on selection in the **Menu** field)
    - Action
    - From Date (input field with available calendar to select date)
    - To Date (input field with available calendar to select date)
    - Override ID (only available based on the selection in the **Menu** field)
    - Fee Schedule (only available based on the selection in the **Menu** field)
    - Code (only available based on the selection in the **Menu** field)
    - Edit (only available based on the selection in the **Menu** field)
    - HCPCS (only available based on the selection in the **Menu** field)
    - Old Value (the value of the field prior to the change)
- New Value (the value of the field after the change)
- Start Date (only available based on the selection in the **Menu** field)
- End Date (only available based on the selection in the **Menu** field)
- Location/Carrier (only available based on the selection in the **Menu** field)
- Effective Date (only available based on the selection in the **Menu** field)
- **when Sys Admin** is selected:
  - User ID (contains all User IDs identified in the database)
  - Menu
  - Field (applicable field name)
  - Action
  - Group
  - From Date (Input field with available calendar to select date)
  - To Date (input field with available calendar to select date)
  - Old Value (the value of the field prior to the change)
  - New Value (the value of the field after the change)

**Results**: The record(s) which apply to the criteria of the search. A summary line is displayed with the following fields:
- **when Rates Audit** is selected:
  - User ID
  - Date/Time
  - Facility
  - NPI
  - Taxonomy
  - Payer ID
  - Pricer Type
  - Grouper
  - Grouper Version
  - Effective Date
  - Field/Table
  - Old Value
  - New Value
  - Source
- **when Editors** is selected:
- User ID
- Date/Time
- Menu
- Override ID (only available based on the selection in the **Menu** field)
- Fee Schedule (only available based on the selection in the **Menu** field)
- Code (only available based on the selection in the **Menu** field)
- Edit (only available based on the selection in the **Menu** field)
- HCPCS (only available based on the selection in the **Menu** field)
- Code (only available based on the selection in the **Menu** field)
- Field
- Start Date (only available based on the selection in the **Menu** field)
- End Date (only available based on the selection in the **Menu** field)
- Location/Carrier (only available based on the selection in the **Menu** field)
- Effective Date (only available based on the selection in the **Menu** field)
- Action
- Old Value
- New Value

- when **Sys Admin** is selected:
  - User ID
  - Date/Time
  - Menu
  - Group
  - Field
  - Action
  - Old Value
  - New Value

Within the **Audit** section, enter the values in which you wish to view and select the **Search** button.

In addition to viewing changes made at the field level, changes made to the database within the **Delete All** utility of Sys Admin are also available for tracking.
7.1.1.1 Export Button: Audit Trail Report
Users have the option of exporting the results of a search to a file that will be located within the directory specified within the File Locations screen of the Sys Admin tool. Select the Export button (at the bottom of the Audit Trail report screen) to create the file in the specified directory.

7.1.1.2 Save Button: Audit Trail Report
Users have the option of saving the results of a search to a local machine. When Save (web version)/Open (Windows® version) is selected, the user will have the option to open the report or save it to a local machine.

7.1.2 All Pay Sources Report
To run the All Pay Sources report, navigate to Reports>All Pay Sources. The All Pay-Sources report provides information on each pay-source set up using Rate Manager. For users with multiple pay-sources, this report serves as a reference to verify that pay-sources were properly entered.

You can specify a facility for this report. If no facility is selected, the report will include all facilities. You must also specify whether this report is for an inpatient or outpatient care setting.

- Filters Panel - Users may utilize this panel to search for particular records using the following options:
  - Facility
  - NPI
  - Payer ID
  - Name (full name for a pay-source)
  - Pricer Type
  - Do Not Export (select if you wish to view if the pay-source has been marked as Do Not Export)

- Advanced Filters Panel - Users may utilize this panel to define more specific search criteria based on available configuration, pricing, editing, and grouping variables. The Advanced Filters drop-down contains all previously saved search filters. The Preview Window displays the search criteria for the filter. The search criteria can quickly be modified by selecting the check box next to the criteria in the Preview Window. Placing the cursor over each criteria will display the entire criteria string in the Hover Help. Selecting Add (only displayed when the search criteria is blank) or Edit (only displayed when a search criteria is displayed) will bring up the Advanced Filter Criteria screen. Selecting Clear will clear any selection in the search filter/criteria.

Note
For additional information on the Advanced Filter Criteria screen, please refer to Chapter 3, Rate Manager User Interface (UI) of this guide.
7.1.2.1 Export Button: Pay Sources Report
Users have the option of exporting the results of a search to a file that will be located within the directory specified within the File Locations screen of the Sys Admin tool. Select the Export button (at the bottom of the Pay Sources report screen) to create the file in the specified directory.

7.1.2.2 Save Button: Pay Sources Report
Users have the option of saving the results of a search to a local machine. When Save (web version)/Open (Windows® version) is selected, the user will have the option to open the report or save it to a local machine.
7.1.3 Pricer Type Details Report

To run the Pricer Type Details report navigate to Reports>Pricer Type Details. The Pricer Type Details report allows users to export specific editing, grouping, and pricing variables and/or weights for all Pricer Types. Users are able to configure the report using the different variables for each Pricer Type. For further information on the different variables please refer to the applicable Rate Variables Worksheet (RVW).

Figure 7-3. Pricer Type Details Report Screen

7.1.3.1 Export Button: Pricer Type Details Report

Users have the option of exporting the results of a search to a file, that will be located within the directory specified within the File Locations screen, of the Sys Admin tool. Select the Export button (at the bottom of the Pricer Type Details report screen) to create the file in the specified directory.

7.1.3.2 Save Button: Pricer Type Details Report

Users have the option of saving the results of a search to a local machine. When Save (web version)/Open (Windows® version) is selected, the user will have the option to open the report or save it to a local machine.
8 System Administration (Sys Admin) Menu

System Administration (Sys Admin) is included as part of your Rate Manager distribution and is used to customize Rate Manager and its components. The Sys Admin tool/menu is a part of the Rate Manager application; it is not a separate application.

This chapter contains the following sections:

- Sys Admin Overview
- System Administration Options
  - File Locations
  - Groups
  - Event Log
  - Preferences
  - Database
  - Delete All
  - Licenses
8.1 Sys Admin Overview

System Administration (Sys Admin) option is located towards the upper right hand corner of the Rate Manager screen, within the available main menu options:

Figure 8-1. Sys Admin Menu

8.1.1 System Administration Options

The System Administration configuration assumes that Rate Manager will be used as a standalone or networked system with a database. If the System Administration is not configured properly, Rate Manager may not function properly.

The following System Administration options are available on the Sys Admin menu:

- File Locations
- Groups
- Event Log
- Preferences
- Database
- Delete All
- Licenses

8.1.2 File Locations

By selecting Sys Admin>File Locations the user will see the File Locations screen. In this screen the user can define or accept the default values for the following:

- System Location
- Database
- References
- Fee + Extended Fee Schedules
- Reports
- Logging
- Export
- Export Queue (allows for a custom path to be set for exports run by the Export Queue functionality)
- Import
- Import Archive

Figure 8-2. File Locations Screen

Add Import Location - (allows the user to enter multiple import file locations when invoked)

8.1.3 Groups

By selecting **Sys Admin>Groups** the user will see the **Groups** screen. This screen allows administrators to customize and set permissions for other groups and users. During the initial installation the **Default** group which grants all access is selected.
Each group has defined privileges which guide those users to a particular set of processes, data updates, and functionality. Below is a list of the permissions types that can be granted/ altered:

- **Core Access**
  - **Delete + Write + Read** - Allows the user the ability to delete, write/alter, and read rate data within Rate Manager.
  - **Write + Read** - Allows the user the ability to write/alter and read rate data within Rate Manager. The user will not be able to delete.
  - **Read** - Allows the user *read only* access within Rate Manager. The user will only be able to view rate data but will not be able to delete and/or alter/modify.
  - **None** - Does not allow the user any access to rate data.

- **Additional Access**
  - **Sys Admin** - Allows access to all System Administration options with the ability to implement and conduct updates to Rate Manager on a server and/or standalone machine.
  - **Reports** - Allows the user access to all reports within Rate Manager.
  - **Import/Export** - Allows the user the ability to import and export data files from within Rate Manager.
- **Editors** - Allows the user to restrict access to the Editors menu within Rate Manager.

**Rate Manager Pro Archive Access**

- **Delete + Write + Read** - Allows the user the ability to delete, write/alter, and read archived rate data within Rate Manager Pro.

- **Write + Read** - Allows the user the ability to write/alter and read archived rate data within Rate Manager Pro. The user will not be able to delete archived data.

- **Read** - Allows the user read only access within Rate Manager Pro. The user will only be able to view archived rate data but will not be able to delete and/or alter/modify.

- **None** - Does not allow the user to access or view Rate Manager Pro functionality.

Groups can be assigned to more than one of the above options. For example, if you create a RateManagerWrite group you may assign it to have Write + Read access, Sys Admin access, as well as Import/Export access, etc.

**To create a new group:**

1. Select the Create New button at the top of the Groups screen.

3. Enter a **Group Name**. Please include the domain name in the new group name (for example: `SERVER01\TestGroup_ReadOnly`)

4. Select the desired permissions for the new group as defined above.

5. Select **Save** to save the new group. You should now see the newly created group on the **Groups** screen. Select **Cancel** to cancel the new group addition and return to the **Groups** screen.

**Note**
If you need to edit your group for any reason, double-click the group name in the **Groups** screen and the **Access Setup** screen will appear. Adjust as needed and then select **Save**.

You may also delete a group by double-clicking the group name on the **Groups** screen, and then select **Delete**.

8.1.3.1 Filtering on the Groups Screen:
Users can sort by **Group Name**, **Permission Type**, and/or **Pro Access Type** to view certain permission types or groups on the **Groups** screen.
To Filter by Group Name:
1. Type in the Group Name you are searching for and select Search. You should now see the group name on the Groups screen.
2. To go back to the original Groups screen, or pre-search items, select Clear.

To Filter by Permission Type:
1. Select the appropriate permission type from the Permission Type drop-down.
2. Select Search.
3. You should now see all available groups with the selected permission type on the Groups screen.

4. To go back to the original Groups screen, or pre-search items, select Clear.

To Filter by Pro Access Type:
1. Select the appropriate access type from the Pro Access Type drop-down.
2. Select Search.
3. You should now see all available groups with the selected access type on the Groups screen.
4. To go back to the original Groups screen, or pre-search items, select Clear.

To Filter by Group Name, Permission Type, and Pro Access Type:
1. Select the appropriate permission type from the Permission Type and Pro Access Type drop-down and enter the desired group name in the Group Name field.
2. Select Search.
3. You should now see all available groups with the selected permission(s) and group name on the Groups screen.
4. To go back to the original Groups screen, or pre-search items, select Clear.

8.1.4 Event Log
By selecting Sys Admin>Event Log the user will see the Event Log Search screen. The Event Log Search screen allows the user to view individual events that occurred within a particular session(s) of Rate Manager. This screen has two panels:

- Event Log Filters Panel
- Results Panel
8.1.4.1 Event Log Filters Panel

The Event Log Filters panel allows the user to search for a specific event. Users can search by:

- **User Id**: The identifier of the user.
- **Status**: The status or classification of the error. The available values in this drop-down box are:
  - Information
  - Warning
  - Error
  - Exception
- **Source**: The location within Rate Manager where the event occurred. The available values in this drop-down box are:
  - Screens
  - Reports
  - SysAdmin
  - Import
  - Export
- Stored Procedure
- Trigger
- WCF
- FileService

- **Description:** The description of the event. This search will locate all descriptions that “contain” the entered wording.

- **From Date:** The date range in which the event occurred (first occurrence). The user can select the calendar icon to select a date or enter the date using a *mm/dd/yyyy* format.

- **To Date:** The date range in which the event occurred (last occurrence). The user can select the calendar icon to select a date or enter the date using a *mm/dd/yyyy* format.

Once all the desired options have been entered, select **Search** or select **Clear** to return to the **Event Log Search** screen.

**8.1.4.2 Results Panel**

Once the user enters their search criteria and selects the **Search** button any and all applicable events will be listed within the **Results** panel.

Each line within this panel represents a specific event. Users can view additional detail on each record by double-clicking on any of the fields for a particular record. The **EventLog Detail** screen will be displayed.
Figure 8-8. EventLog Detail Screen

The EventLog Detail screen provides more detail on a specific event. These details include two additional fields:

- Description Detail
- Data

8.1.5 Preferences

By selecting Sys Admin>Preferences the user will see the Preferences screen. The Preferences screen allows the user to adjust certain settings for the following items:

- Application Panel
- Event Log Panel
- Audit Trail Panel
- Payer ID Import Override Panel
- Effective Date Default Panel
- Fee Schedule + Extended Fee Schedule Export Format Panel
- Default Pricing Variables Panel

Figure 8-9. Preferences Screen

8.1.5.1 Application Panel
Under the Application panel the user can enter a custom header to be displayed across the top of the Rate Manager screen (for example, Claims Adjustor’s Rate Manager).

8.1.5.2 Event Log Panel
In the Event Log panel the user has the option to:
- Turn the Event Log On or Off.
- Adjust the TimeFrame (i.e., the time period to capture transactional data). The following time frames are available:
  - 1 - 6 Day(s)
  - 1 Week
  - 1 Month
8.1.5.3 Audit Trail Panel
In the Audit Trail panel the user has the following options:

- **Import** or UI: The method in which the auditing information is handled. The default setting is **Import**.

- Adjust the **TimeFrame** (i.e., the time period to capture auditing data). The following time frames are available:
  - 1 Week
  - 1, 2, 3, or 6 Month(s)
  - 1 Year

8.1.5.4 Payer ID Import Override Panel
In the Payer ID Import Override panel the user has the following options:

- Old
- New
- Update Shared Facility Weights

These options allow you to import a set of rate files with a specific Payer ID and save them with a new Payer ID that you specify prior to import. For example: entering 09 in the Old field and entering 20 in the New field will change all records being imported with the Payer ID of 09 to a Payer ID of 20.

![Figure 8-10. Update Shared Facility Weights Check Box](image)

Selecting **Update Shared Facility Weights** will change the Payer ID(s) of record(s) that are being shared to those facilities.

**Note**
The **Update Shared Facility Weights** check box only appears after data has been entered in the **Old** and **New** fields.

For example: importing Facility 123 with Payer ID 09 that is shared to Facility 999; Payer ID 09 will be imported into the database as Facility 123, Payer ID 20 with shared Facility 999, Payer ID 20. If you uncheck the **Update Shared Facility Weights** check box the facility would be Facility 123, Payer ID 20 with shared Facility 999, Payer ID 09.
Important
Please note any facilities in the import file that share weights with facilities using the Old Payer ID entered, will not be shared with the facility using the New Payer ID entered.

8.1.5.5 Effective Date Default Panel
In the Effective Date Default panel the user has the following option:

- Turn the effective date default On or Off.

8.1.5.6 Fee Schedule + Extended Fee Schedule Export Format Panel
In the Fee Schedule + Extended Fee Schedule Export Format panel the user has the option to select C (default) or COBOL for the export format.

Note
This only applies to the export option with the Editors menu.

Once all options on the Preferences screen have been selected, select Save or select Cancel to revert back to the previous settings.

8.1.5.7 Default Pricing Variables Panel
In the Default Pricing Variables panel the user has the ability to turn on/off default pricing variables when creating a new rate record/effective date. By default, the On radio button will be selected. When the On radio button is selected, the default pricing variables will display when creating a new rate record/effective date. When the Off radio button is selected:

- All pricing variables will be set to zero(s) based on the format of each field.
- All pricing check boxes will be unchecked.
- All pricing drop-down selections will be set to blank.
- All date fields will be set to blank.

8.1.6 Database
By selecting Sys Admin>Database the user will see the Create Database screen. The Create Database screen allows the user to create or update a Rate Manager database (i.e., to the most current version installed).
To Update or Create a Database:

1. In the **Authentication** section, select **SQL**.
2. Provide the **User Name** and **Password** for the Sys Admin account associated with the SQL instance that Rate Manager is installed to.
3. In the **SQL Server Path** section, select the **Get Default Path** button to populate the path for the SQL installation.
4. In the **SQL Log Path** section, enter the storage location for the **Transaction Log File (.ldf)** associated with the database.
5. In the **Database Name** section, select which Rate Manager database you wish to update or create. Selecting **RateManager** will upgrade the default database. Selecting **RateManager_** will require you to provide the name of the custom database to be created or updated. Selecting the **RateManager_** drop-down will upgrade any existing custom databases you choose. Selecting **All** will upgrade all databases.
6. Select **Create Database** or **Upgrade Database** depending on the action you wish to perform.

8.1.7 Delete All

By selecting **Sys Admin>Delete All** the user will see the **Delete All** screen. The **Delete All** screen allows the user to delete the following specific sets of data contained within the database:
Important
Please use caution when deleting items from the Rate Manager database.

- All Rates
- Custom Fee Schedules
- Custom Extended Fee Schedules
- ACE Override Editor
- Contract APC Rules
- Contract ASC Rule
- Mapping Rule
- Physician Code Table
- Record Locks
- Custom Filters

Figure 8-12. Delete All Screen

Note
Users also have the option to Check / Uncheck All on the Delete All screen.
Select **Submit** when you are finished selecting the appropriate items to delete. Select **Close** at the bottom of the screen to return to the Rate Manager screen.

8.1.8 Licenses

The Licenses screen (**Sys Admin > Licenses**) contains the current status of your Rate Manager Pro license, the expiration date of your current license, and a text box to enter a new license key. To enter a new license key, please refer to the Rate Manager Installation Guide for further information.

Figure 8-13. Licenses
9 Utilities Menu

This chapter includes the following sections:

• Import
• Export
  - Export File Names

Note
For information on the Archive screen, please refer to the Rate Manager Pro chapter of this guide.
9.1 Import

9.1.1.1 Files Acceptable for Importing

- Rate Files (i.e., config.dat, medcalc.dat, rate.dat, payors.dat)

**Important**
Rate Files must be imported as complete sets. Importing incomplete sets of rate files or individual rate files will compromise data integrity and impact claims processing accuracy. Only import complete sets of rate files.

- Configuration/Rule Files (i.e., acerule.dat, apcrule.dat, ascrule.dat, maprule.dat, codephys.dat, facphyyy.dat)

- Custom Fee Schedule and Extended Fee Schedule Files
  - File name criteria:
    1. File name must start with `fs` (for 2016 custom fee schedule), `fee` (for 2017 custom fee schedule) or `ex` (for 2016 custom extended fee schedule).
    2. File name must be less than or equal to thirteen characters.
    3. File name must not contain special characters (i.e., !, *, #, ;, ?, \, /, :, ", <, >).
    4. File name cannot be the same as an Optum supplied fee/extended fee schedule file.

To run an import select **Utilities>Import**. This will bring you to the **Import** screen. This utility allows the user to import all applicable C/Windows® format files from the locations specified within the **File Locations** screen of the **Sys Admin** menu.
To begin the import process select the **Import** button located in the bottom right of the screen. Once the **Import** button is selected the process will begin importing rate files from all import locations provided in the **Sys Admin > File Locations** menu. The entire process may take a few minutes but the user can monitor the process via the display panel. An example import log is shown below in Figure 9-2.
9.1.2.2 Import Error Logging

The import process supports advance error handling that identifies and quarantines rate records that include invalid data. A record identified during this import process indicates that they are un-usable within Optum software. Any record found that is an error will not be included in the Rate Manager database. These error records will be written to the Logging folder specified within the SysAdmin > File Locations menu.

In addition to the data file containing the invalid rate records, a text file containing the corresponding error messages will also be written to the Logging directory.

Figure 9-3. Data File and Text File
9.2 Export

To run an export select Utilities > Export. This will bring you to the Export screen. This utility allows the user to export all applicable C/Windows® or COBOL format files to the location specified within the File Locations screen of the Sys Admin menu.

Choose which Export Format to export:

- C (Windows® Platform)
- COBOL (COBOL Platform)

Choose which Export Set to export:

- All Rates
- Export Queue
- Filtered
- Fee Schedules (C Only)

The UI and Export functionality will behave differently based on the Export Set selected.

9.2.1.1 All Rates Option

The All Rates option will export a complete set of rates based on all data in the selected Rate Manager database. Rate calculators that have been set to Do Not Export will not be included.

Selecting All Rates from the Export Set selection will display a running log of current progress during an export process. There is also an Export and Close button in the bottom right.
9.2.2.2 Export Queue
The Export Queue option will export rates only for the specified facilities that have been added to the Export Queue and are visible within this Export Queue screen.

Selecting Export Queue will display a list of facilities that are currently added to the Export Queue, as well as a running an export log when the export is in progress (as shown in Figure 9-6).

Users will be able to navigate to the Rate Calculator screen for review or modification of any facility within the Export Queue by double-clicking on the listed facility. In addition to the Export and Close buttons, this Export Set option will provide a Clear Queue button.

Selecting Clear Queue will cause a prompt stating Are you sure you want to remove all records from the Export Queue? Selecting OK to this option will remove all records from the Export Queue. Facilities will need to be re-added to the queue once removed via Clear Queue selection. Selecting Cancel will take no action and return to the Export Queue screen to continue with Export selections.

Important
When adding a facility to the Export Queue if an individual rate calculator shares weights with another facility, that shared facility will also be automatically included as part of the Export. This is to allow for a fully functional set of rates.
Example:
Facility 123 has shared weights with Facility B
Facility 123 has been added to the Export Queue
Facility B will also be exported automatically within the Export Queue in order to produce an associated rate file

Figure 9-6. Example Export - Export Queue Option

**9.2.3.3 Filtered**
The Filtered option will export a set of rates based on the search criteria entered by the user and the results displayed on the screen. Selecting Filtered will display an Export Filters screen which will allow the user to narrow down specific export results. Users will be able to filter the facilities to be exported based on the following criteria:

- Facility
- NPI
- Payer ID
- Name
- Pricer Type

After entering specific criteria the user will be able to select the Search button and return a display of all facilities that will be exported. To export based on other criteria after initial search user may select Clear button and enter in different criteria to search once again. Users will be able to navigate to the
Rate Calculator screen for review or modification of any facility within the Filtered selection by double-clicking on the listed facility.

Important
When using the Filtered selection only records that fall under the searched criteria will be exported. If a facility within the results shares weights with a facility that does not meet the searched criteria, those weights will not be exported.

Figure 9-7. Example Export - Filtered Option

9.2.4.4 Fee Schedules Option

Note
The Fee Schedules option is only available if C is selected in the Export Format selection.

The Fee Schedules option will allow you to export multiple custom fees schedules and/or extended fee schedules at one time. Selecting Fee Schedules from the Export Set selection will display a list of custom fees schedules and/or extended fee schedules in the Rate Manager database. All custom fees schedules and/or extended fee schedules will be checked by default.

Users will be able to navigate to the Fee Schedule Editor screen for review or modification of any custom fee schedule and/or extended fee schedule listed by double-clicking on the listed custom fee schedule or extended fee schedule.
To export the custom fees schedules and/or extended fee schedules, you can either uncheck the ones you do not wish to export from the list or you can uncheck the **Check / Uncheck All** selection and check the ones you wish to export from the list. Once you are ready to export, you may click the **Export** button on the bottom right of the screen to start the process. When the process has started, users will see a running log of current progress during the export process.

Figure 9-8. Example of Export - Fee Schedules Option
### 9.2.5 Export File Names

#### Table 9-1: Export File Names

<table>
<thead>
<tr>
<th>C Export File Names</th>
<th>COBOL Export File Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>config.dat</td>
<td>EZGCONFIG.DAT</td>
<td>Configuration File containing edit request data (beginning 10/1/2008) for inpatient, outpatient, rehabilitation facility, and skilled nursing</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C Home Health Export File Names</th>
<th>COBOL Home Health Export File Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>medout.dat</td>
<td>HOSPRATE.DAT</td>
<td>Contains all values (per the Rate Variables Worksheet (RVW)) for home health pricing</td>
</tr>
<tr>
<td>rateout.dat (prior to January 01, 2020)</td>
<td>WGHTRATE.DAT (prior to January 01, 2020)</td>
<td>Contains all HHRG weights</td>
</tr>
<tr>
<td>ratehha.dat (effective January 01, 2020)</td>
<td>WGHTHHA.DAT (effective January 01, 2020)</td>
<td>Contains all PDGM weights</td>
</tr>
<tr>
<td>payors.dat</td>
<td>N/A</td>
<td>Contains all home health facility names</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C Inpatient Export File Names</th>
<th>COBOL Inpatient Export File Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>medcalc.dat</td>
<td>HOSPRATE.DAT</td>
<td>Contains all values (per the Rate Variables Worksheet (RVW)) for inpatient pricing</td>
</tr>
<tr>
<td>medext.dat</td>
<td>HOSPEXT.DAT</td>
<td>Contain all values (per RVW) for Medicare Inpatient, Medicaid APR Pro, and Contract Multi-Pricer pricing</td>
</tr>
<tr>
<td>rate.dat</td>
<td>WGHTRATE.DAT</td>
<td>Contains all DRG weights</td>
</tr>
<tr>
<td>payors.dat</td>
<td>N/A</td>
<td>Contains all inpatient facility names</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C Outpatient Export File Names</th>
<th>COBOL Outpatient Export File Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>medext.dat</td>
<td>HOSPEXT.DAT</td>
<td>Contains all values (per the RVW) for Contract APC and Medicare ESRD pricing</td>
</tr>
<tr>
<td>medout.dat</td>
<td>HOSPRATE.DAT</td>
<td>Contains all values (per the RVW) for outpatient pricing</td>
</tr>
<tr>
<td>rateout.dat (prior to January 01, 2018)</td>
<td>WGHTRATE.DAT (prior to January 01, 2018)</td>
<td>Contains all APC rates</td>
</tr>
<tr>
<td>rateapc.dat (effective January 01, 2018)</td>
<td>WGHTAPC.DAT (effective January 01, 2018)</td>
<td>Contains all New York Medicaid APG rates</td>
</tr>
<tr>
<td>rateny.dat</td>
<td>N/A</td>
<td>Contains all New York Medicaid APG rates</td>
</tr>
</tbody>
</table>
### Table 9-1: Export File Names

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>payout.dat</td>
<td>Contains all outpatient facility names</td>
</tr>
<tr>
<td>medirf.dat</td>
<td>COBOL Rehabilitation Export File Names</td>
</tr>
<tr>
<td>ratesirf.dat</td>
<td>Contains all CMG rates</td>
</tr>
<tr>
<td>payirf.dat</td>
<td>Contains all rehabilitation facility names</td>
</tr>
<tr>
<td>medsnf.dat</td>
<td>COBOL Skilled Nursing Export File Names</td>
</tr>
<tr>
<td>ratesnf.dat</td>
<td>Contains all values (per the RVW) for Skilled Nursing Facility (SNF) pricing</td>
</tr>
<tr>
<td>ratesnf2.dat</td>
<td>Contains all RUG rates</td>
</tr>
<tr>
<td>paysnf.dat</td>
<td>Contains all skilled nursing facility names</td>
</tr>
<tr>
<td>medphys.dat</td>
<td>COBOL Physician Export File Names</td>
</tr>
<tr>
<td>payphys.dat</td>
<td>Contains all physician names</td>
</tr>
<tr>
<td>ratephys.dat</td>
<td>Contains all physician rates</td>
</tr>
<tr>
<td>feealbcyy.dat</td>
<td>Alabama BCBS Outpatient Fee Schedule Data Files. The “yy” indicates the year for the fee schedule (e.g. feealbc20.dat).</td>
</tr>
<tr>
<td>feeyyyy.dat</td>
<td>APC-HOPD Fee Schedule Data Files. Where “yyyy” indicates the year for the fee schedule (e.g., fee2017.dat).</td>
</tr>
<tr>
<td>Legacy Layout:</td>
<td></td>
</tr>
<tr>
<td>fsyyyy.dat</td>
<td>Contract APC Fee Schedule Data Files. The “yy” indicates the year for the fee schedule (e.g., fee2018.dat or fee2017.dat).</td>
</tr>
<tr>
<td>New Layout:</td>
<td></td>
</tr>
<tr>
<td>feeyyyy.dat</td>
<td></td>
</tr>
</tbody>
</table>
### Table 9-1: Export File Names

<table>
<thead>
<tr>
<th>File Name</th>
<th>Area Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>feeascyy.dat</td>
<td>N/A</td>
<td>ASC Fee Schedule Data Files. The &quot;yy&quot; indicates the year for the fee schedule (e.g. feeasc17.dat).</td>
</tr>
<tr>
<td>Legacy Layout:</td>
<td></td>
<td>fsascyy.dat Contract ASC Fee Schedule Data Files. The &quot;yy&quot; indicates the year for the fee schedule (e.g. fsasc17.dat or feeasc17.dat).</td>
</tr>
<tr>
<td>New Layout:</td>
<td></td>
<td>feeascyy.dat</td>
</tr>
<tr>
<td>feecooyy.dat</td>
<td>N/A</td>
<td>Colorado Medicaid Outpatient Fee Schedule Data Files. The &quot;yy&quot; indicates the year for the fee schedule (e.g. feeco19.dat).</td>
</tr>
<tr>
<td>feesrdyy.dat</td>
<td>N/A</td>
<td>End Stage Renal Disease (ESRD) Fee Schedule Data Files. The &quot;yy&quot; indicates the year for the fee schedule (e.g. feesrd17.dat).</td>
</tr>
<tr>
<td>feefqyy.dat</td>
<td>N/A</td>
<td>Federally Qualified Health Centers (FQHC) Fee Schedule Data Files. The &quot;yy&quot; indicates the year for the fee schedule (e.g. feefq17.dat).</td>
</tr>
<tr>
<td>feehhyy.dat</td>
<td>N/A</td>
<td>Home Health Agency (HHA) Fee Schedule Data Files. The &quot;yy&quot; indicates the year for the fee schedule (e.g. feehh17.dat).</td>
</tr>
<tr>
<td>feiayyy.dat</td>
<td>N/A</td>
<td>Iowa Outpatient Fee Schedule Data Files. The &quot;yy&quot; indicates the year for the fee schedule (e.g. feiay17.dat).</td>
</tr>
<tr>
<td>feemayy.dat</td>
<td>N/A</td>
<td>Massachusetts Outpatient Fee Schedule Data Files. The &quot;yy&quot; indicates the year for the fee schedule (e.g. feema17.dat).</td>
</tr>
<tr>
<td>feemiyy.dat</td>
<td>N/A</td>
<td>Michigan Outpatient Fee Schedule Data Files. The &quot;yy&quot; indicates the year for the fee schedule (e.g. feemi17.dat).</td>
</tr>
<tr>
<td>feemiayy.dat</td>
<td>N/A</td>
<td>Michigan ASC Fee Schedule Data Files. The &quot;yy&quot; indicates the year for the fee schedule (e.g. feemia17.dat).</td>
</tr>
<tr>
<td>feeneyy.dat</td>
<td>N/A</td>
<td>Nebraska Outpatient Fee Schedule Data Files. The &quot;yy&quot; indicates the year for the fee schedule (e.g. feene20.dat).</td>
</tr>
<tr>
<td>feenmyyy.dat</td>
<td>N/A</td>
<td>New Mexico Outpatient Fee Schedule Data Files. The &quot;yy&quot; indicates the year for the fee schedule (e.g. feenm20.dat).</td>
</tr>
<tr>
<td>File Name</td>
<td>Year</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>feenyy.dat</td>
<td>N/A</td>
<td>New York Outpatient Fee Schedule Data Files. The “yy” indicates the year for the fee schedule (e.g. feen17.dat).</td>
</tr>
<tr>
<td>feeohyy.dat</td>
<td>N/A</td>
<td>Ohio Outpatient Fee Schedule Data Files. The “yy” indicates the year for the fee schedule (e.g. feeoh17.dat).</td>
</tr>
<tr>
<td>feephysyy.dat</td>
<td>N/A</td>
<td>Physician Fee Schedule Data Files. The “yy” indicates the year for the fee schedule (e.g. feephys17.dat). The Physician Payment Factor File (facphyyy.dat; fac09yy.dat) is also included.</td>
</tr>
<tr>
<td>feesnfy.dat</td>
<td>N/A</td>
<td>Skilled Nursing Facility (SNF) Fee Schedule Data Files. The “yy” indicates the year for the fee schedule (e.g. feesnf17.dat).</td>
</tr>
<tr>
<td>feevayy.dat</td>
<td>N/A</td>
<td>Virginia Outpatient Fee Schedule Data Files. The “yy” indicates the year for the fee schedule (e.g. feeva17.dat).</td>
</tr>
<tr>
<td>feevaasyy.dat</td>
<td>N/A</td>
<td>Virginia ASC Fee Schedule Data Files. The “yy” indicates the year for the fee schedule (e.g. feevaas17.dat).</td>
</tr>
<tr>
<td>feewayy.dat</td>
<td>N/A</td>
<td>Washington Medicaid APG Fee Schedule Data Files. The “yy” indicates the year for the fee schedule (e.g. feewa17.dat).</td>
</tr>
<tr>
<td>feewiyy.dat</td>
<td>N/A</td>
<td>Wisconsin Medicaid APG Fee Schedule Data Files. The “yy” indicates the year for the fee schedule (e.g. feewi17.dat).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C Support Module Export File Names</th>
<th>COBOL Support Module Export File Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ascrule.dat</td>
<td>ascrule.dat</td>
<td>ASC Rule File</td>
</tr>
<tr>
<td>apcrule.dat</td>
<td>apcrule.dat</td>
<td>APC Rule File</td>
</tr>
<tr>
<td>acerule.dat</td>
<td>acerule.dat</td>
<td>ACE Override File</td>
</tr>
<tr>
<td>codephys.dat</td>
<td>codephys.dat</td>
<td>Physician Code Table File</td>
</tr>
<tr>
<td>maprule.dat</td>
<td>maprule.dat</td>
<td>Mapping Configuration File</td>
</tr>
<tr>
<td>facphyyyy.dat</td>
<td>fac09yy.dat</td>
<td>Physician Payment Factor File</td>
</tr>
</tbody>
</table>
10 Rate Manager Pro

This chapter includes the additional features only included with Rate Manager Pro. This chapter includes the following sections:

• Rate Manager Pro
• Additional Features
  - Utilities Menu
  - Home/Search Screen
  - Rate Variable Screen
  - Sys Admin Menu
  - Reports Menu
10.1 Rate Manager Pro

Rate Manager Pro is a separately licensed add-on module to the standard Rate Manager application that features rate archiving capabilities. It allows users to capture and report on point-in time snapshots of rate data as it existed when moved into production for claims processing. Rate Manager Pro provides additional features which are mentioned in this chapter.

Figure 10-1. Rate Manager Pro Archive Dashboard

10.2 Additional Features

The following screens/menus have additional features that are included with Rate Manager Pro:

- Utilities Menu
- Home/Search screen
- Rate Variables screen
- Sys Admin Menu
- Reports Menu

These additional features are discussed in further details below.
10.2.1 Utilities Menu

Rate Manager Pro contains an Archive dashboard (Utilities > Archive). This Archive dashboard allows you view and manage archive data. You can filter, search, sort, add, delete, or view archive details within this screen.

Figure 10-2. Archive Dashboard

10.2.2.1 Filter

You can filter for specific criteria within each data element (Production Date, Name, Status, or Source) on the screen.

To filter for specific criteria, enter a specific value in the appropriate text box and the results will automatically update. The auto filter operates by looking for data that contains the specific value entered in the appropriate text box.

Figure 10-3. Data Element Filters

10.2.3.2 Search

You can search the rate records within a specific completed archive by clicking the search icon within the archive row. Once clicked, Rate Manager Pro will automatically direct you to the Search screen which will contain all the rate records within that Production Date archive.

Figure 10-4. Search Icon
10.2.4.3 Sorting
You can sort the list of archives by choosing the up/down sorting arrows in the applicable column. When selecting the up/down arrows, the column will first be sorted in ascending order. By selecting the up arrow again, the data will then be sorted in descending order.

Figure 10-5. Sorting Arrows

10.2.5.4 Adding an Archive
You can add new archives under a new Production Date. A new Archive will consist of either the facilities already included in the Export Queue, or a complete set of rate files, or by Archive All, which will archive the entire Rate Manager database. To add an archive:

1. Click the Add button on the top left-side of the Archive dashboard.
2. The **Add to Archive** dialog box will appear. Enter a new archive date in the **Production Date** field or select the calendar icon and select a date. You may also enter a **Name** and/or **Notes** in the applicable fields. Click **Next** to continue.

**Note**
If you select/enter an existing Production Date in your database, a message will appear as shown below in **Figure 10-8**.

---

**Figure 10-7. Add to Archive Dialog Box**
3. Select a data source from the **Select Data Source** section. The following options are available:

   a. **Export Queue** - When you select this option, you will see a Select Editor Files section. Select one or more of the options or select the **Check/Uncheck All** check box to select all the options. Select **Next** to continue.
b. **Import Rate Files** - When you select this option, a default **File Location** path will appear. You can change the default by entering another path in the text-box. Select **Next** to continue.
c. **Archive All Rates** - When this option is selected, you see a warning. Select **Next** to continue.
Figure 10-11. Archive All Rates Option Within the Add to Archive Dialog Box

4. You will see a summary of the options you choose in the previous steps. Confirm that all the information is correct and click **Finish** to start the archive process. If something isn't correct, click **Previous** to go to the previous step or **Cancel** to close the dialog box.
Figure 10-12. Summary Example Within the Add to Archive Dialog Box

**Add To Archive**

In this window, users can add new Archives under a new Production Date, or remove and replace an existing Archive by choosing an existing Production Date. A new Archive will consist of either the facilities already included in the Export Queue, or a complete set of Rate Files, or by Archive All, which will archive the entire Rate Manager database (not recommended).

- **Production date**: 5/1/2020
- **Name**: V2005.00
- **Source type**: Export Queue
- **Editor files included**: Contract APC Rule, Contract ASC Rule
- **Notes**: NMRF

### 10.2.6.5 Delete archive

To delete an archive:

1. Select the delete icon within that row in the Actions column.
2. The Delete dialog box will appear. Click OK to continue the delete process or Cancel to close the dialog box.

10.2.7.6 View Archive Details
To view the archive details:

1. Select the Show Details icon.
2. The **Archive Details** dialog box will appear. The following information is displayed:

   a. **Production Date** - The date that was assigned by the user during the archive process.

   b. **Name** - The name of the archive that was entered during the archive process.

   c. **Notes** - The notes entered during the archive process.

   d. **Source Type & details** - The source type used along with the details (e.g., Editor files, file location) for that source type.

   e. **User** - The user that processed the archive.

   f. **Start Time** - The start time of the archiving process.

   g. **End Time** - The end time of the archiving process.

   h. **Status** - The status of the archive (e.g., completed, error, or in progress).

   i. **Log File** - If you click on the **Show Details** hypertext, the details of the archiving process will open in a log file.
At the bottom right-side of the Archive Details screen, you will see the following four action buttons:

- **Save** - This will save any changes made to the **Production Date**, **Name**, or **Notes**.

- **Delete** - This will permanently delete the rate data associated with that archive. When this button is selected, you will receive a message to confirm you want to delete.

- **Archive** - This allows users to archive data using the current **Production Date**, **Name**, **Notes**, **Source type**, **Editor Files**, and **File Location** displayed in Archive Details. Selecting a new **Production Date** will create a new archive with the detail provided. Selecting an
existing **Production Date** will overwrite the existing archive details with the detail provided.

Figure 10-18. Archive Confirmation Message

- **Cancel** - This will cancel any changes and close the dialog box.

10.2.8 Home/Search Screen

With Rate Manager Pro, the Home/Search screen has an additional **Production Date** feature. The **Production Date** is the date assigned by the user during the rate file archive process and indicates the date that the rates were moved into production for claims processing. The Search screen includes a **Production Date** column and a **Production Date** drop-down in the Filters panel. Please note that a value of **Current** selected in the drop-down menu will display facilities in the standard Rate Manager database. For further information about the basic functionality of the Search screen, please refer to Chapter 3 of this guide.

Figure 10-19. Rate Manager Pro Production Date in the Search Screen
10.2.9 Rate Variable Screen

In the **Rate Variable** screen for Rate Manager Pro, you will have a **Production Date** drop-down and a **Quick Compare** button located in the top right-side of the screen. These features are discussed in further detail below. For further information about the basic functionality of the **Rate Variable** screen, please refer to Chapter 4 of this guide.

Figure 10-20. Rate Manager Pro Rate Variable Screen

---

10.2.10.1 Production Date Drop-Down

The **Production Date** drop-down contains a list of production dates that the currently selected paysource and effective date are archived to.

10.2.11.2 Quick Compare

The **Quick Compare** button allows you to compare rate data for multiple effective dates and/or production dates. You are allowed to compare up to a combination two of each (e.g., two effective date and two production dates) or up to three of either (e.g., three effective dates or three production dates).

To compare:

1. Click the **Quick Compare** button.
2. Once selected, the **Quick Compare** dialog box will appear.
Figure 10-21. Quick Compare Dialog Box

3. Select dates from the **Effective** and/or **Production Date** drop-downs.
4. If you only want to see the differences, select the **Show Differences** check-box.
5. Once you have made your selection(s), click the **Compare** button.
6. You can click **Save** to open and/or save the results or **Cancel** to close the dialog box.

### 10.2.12 Sys Admin Menu

The **Groups** screen within the **Sys Admin** menu has additional features with Rate Manager Pro. This additional feature is discussed in further detail below.

#### 10.2.13.1 Groups

The **Groups** screen allows you to customize and set permissions for other groups and users. With Rate Manager Pro, you can customize and set different access levels for the standard Rate Manager (**Core Access**) and Rate Manager Pro (**Pro Access**). You can create a new group by clicking the **Create New** button or update an existing group’s access by double-clicking the group row which will open the **Access Setup** dialog box. For further information on the **Groups** screen, please refer to Chapter 8 of this guide.
Note

Users will need at least **Read** access to view Rate Manager Pro features.

Figure 10-23. Rate Manager Pro Groups Screen
10.2.14 Reports Menu

Within the Reports > Audit Trail menu you can run audit reports for archives by selecting the Archive radio button within the Audit Selection section. For further information about the basic functionality of the Audit Trail screen, please refer to Chapter 7 of this guide.

When Archive is selected, the following fields are available in the Audit section:

- User ID
- Field
- Action
- Production Date
- Name
- Notes
- From Date
- To Date
- Status
- Source
- Editor Files
- Old Value
- New Value

In addition, the following fields are available in the **Results** section:
- User ID
- Date/Time
- Production Date
- Name
- Notes
- Source
- Import Path
- Editor Files
- Status
- Field
- Action
- Old Value
- New Value
Figure 10-25. Audit Trail
List of Tables

Guide Contents 5

Technical Support Options 7

APC Rule File Fields That Populate Medicare Default Values 50

Copy Functionality 97

Export File Names 136
## List of Figures

<table>
<thead>
<tr>
<th>Figure Description</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate Manager Main/Home Screen</td>
<td>13</td>
</tr>
<tr>
<td>Advanced Filters Section</td>
<td>16</td>
</tr>
<tr>
<td>Advanced Filter Criteria Screen</td>
<td>17</td>
</tr>
<tr>
<td>Create New Filter Screen</td>
<td>18</td>
</tr>
<tr>
<td>Custom Filters Panel</td>
<td>18</td>
</tr>
<tr>
<td>Criteria Grid</td>
<td>19</td>
</tr>
<tr>
<td>Criteria Panel</td>
<td>20</td>
</tr>
<tr>
<td>Example of Locked Status Bar and Unlock Button</td>
<td>22</td>
</tr>
<tr>
<td>Rate Variable Screen</td>
<td>24</td>
</tr>
<tr>
<td>Creating a New Rate Calculator Record</td>
<td>26</td>
</tr>
<tr>
<td>Modifying a Pay-Source</td>
<td>27</td>
</tr>
<tr>
<td>Pay Source Pricer Save As Dialog Box</td>
<td>28</td>
</tr>
<tr>
<td>Modifying Rate Calculator Data</td>
<td>29</td>
</tr>
<tr>
<td>Pricing and State Identifier Section</td>
<td>30</td>
</tr>
<tr>
<td>Procedure Editor Screen</td>
<td>30</td>
</tr>
<tr>
<td>Base and Capital Rates Button</td>
<td>31</td>
</tr>
<tr>
<td>Base and Capital Rates Editor</td>
<td>32</td>
</tr>
<tr>
<td>Base and Capital Rates Editor Detail Pop-Up</td>
<td>32</td>
</tr>
<tr>
<td>Editors Menu</td>
<td>35</td>
</tr>
<tr>
<td>ACE Override ID Editor Screen</td>
<td>36</td>
</tr>
<tr>
<td>ACE Override ID Creation Screen</td>
<td>37</td>
</tr>
<tr>
<td>ACE Override ID Edit Creator Screen</td>
<td>38</td>
</tr>
<tr>
<td>Delete Confirmation Box</td>
<td>39</td>
</tr>
<tr>
<td>APC Grouper Editor Screen</td>
<td>40</td>
</tr>
<tr>
<td>Search Criteria Box</td>
<td>40</td>
</tr>
<tr>
<td>APC Grouper Editor Detail Screen</td>
<td>41</td>
</tr>
<tr>
<td>HCPCS Detail Screen</td>
<td>42</td>
</tr>
<tr>
<td>APC Grouper Editor Detail Screen Delete Button</td>
<td>43</td>
</tr>
<tr>
<td>Creating a New Override ID</td>
<td>44</td>
</tr>
<tr>
<td>APC Override ID Creation Screen</td>
<td>45</td>
</tr>
<tr>
<td>New APC Override ID</td>
<td>46</td>
</tr>
<tr>
<td>Create New HCPCSC Button Within the APC Grouper Editor Screen</td>
<td>47</td>
</tr>
<tr>
<td>HCPCS Detail Screen</td>
<td>48</td>
</tr>
<tr>
<td>New HCPCS Code Added</td>
<td>49</td>
</tr>
<tr>
<td>APC Grouper Editor Export Process</td>
<td>50</td>
</tr>
<tr>
<td>ASC Grouper Editor Screen</td>
<td>52</td>
</tr>
<tr>
<td>Search Criteria Box</td>
<td>53</td>
</tr>
<tr>
<td>ASC Grouper HCPCS Detail Screen</td>
<td>54</td>
</tr>
<tr>
<td>Fee Schedules Screen</td>
<td>56</td>
</tr>
<tr>
<td>Fee Schedule Editor Screen</td>
<td>57</td>
</tr>
<tr>
<td>Feature</td>
<td>Screen Name</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Search for a Record Within a Fee Schedule</td>
<td>57</td>
</tr>
<tr>
<td>Fee Schedule Editor Detail Screen</td>
<td>58</td>
</tr>
<tr>
<td>Create a Custom Fee Schedule Screen</td>
<td>59</td>
</tr>
<tr>
<td>Fee Schedule Editor Screen</td>
<td>60</td>
</tr>
<tr>
<td>Add New HCPCS Code Button</td>
<td>61</td>
</tr>
<tr>
<td>Create New HCPCS Window</td>
<td>62</td>
</tr>
<tr>
<td>Fee Schedule Editor Detail Screen</td>
<td>63</td>
</tr>
<tr>
<td>Extended Fee Schedule Screen</td>
<td>64</td>
</tr>
<tr>
<td>Search for an Extended Fee Schedule</td>
<td>65</td>
</tr>
<tr>
<td>Extended Fee Schedule Editor Screen</td>
<td>66</td>
</tr>
<tr>
<td>Extended Fee Schedule Editor Detail Screen</td>
<td>67</td>
</tr>
<tr>
<td>Create Custom Extended Fee Schedule Screen</td>
<td>68</td>
</tr>
<tr>
<td>Extended Fee Schedule Editor Screen</td>
<td>69</td>
</tr>
<tr>
<td>Add New HCPCS Code Button</td>
<td>70</td>
</tr>
<tr>
<td>Extended Fee Schedule Editor Detail Screen</td>
<td>70</td>
</tr>
<tr>
<td>Extended Fee Schedule Editor Detail Screen</td>
<td>71</td>
</tr>
<tr>
<td>Mapping Configuration Editor Screen</td>
<td>72</td>
</tr>
<tr>
<td>Override ID Creation Screen</td>
<td>73</td>
</tr>
<tr>
<td>DX/PX Code Details Screen</td>
<td>75</td>
</tr>
<tr>
<td>Physician Code Table Screen</td>
<td>77</td>
</tr>
<tr>
<td>Filters Panel</td>
<td>78</td>
</tr>
<tr>
<td>Filtering Example</td>
<td>78</td>
</tr>
<tr>
<td>Physician Code Table Detail Dialog Box</td>
<td>79</td>
</tr>
<tr>
<td>Create New Code Button</td>
<td>80</td>
</tr>
<tr>
<td>New Entered Code Example</td>
<td>81</td>
</tr>
<tr>
<td>Physician Payment Factor Screen</td>
<td>82</td>
</tr>
<tr>
<td>Physician Payment Factor Editor Screen</td>
<td>83</td>
</tr>
<tr>
<td>Physician Payment Factor Filters Panel</td>
<td>83</td>
</tr>
<tr>
<td>Filtering Example</td>
<td>84</td>
</tr>
<tr>
<td>Physician Payment Factor Editor Filters Panel</td>
<td>85</td>
</tr>
<tr>
<td>Physician Payment Factor Editor Search Example</td>
<td>85</td>
</tr>
<tr>
<td>Create Custom Physician Payment Factor File Button</td>
<td>86</td>
</tr>
<tr>
<td>Create Custom Physician Payment Factor File Dialog Box</td>
<td>87</td>
</tr>
<tr>
<td>Add New Phys Payment Factor Button</td>
<td>88</td>
</tr>
<tr>
<td>Physician Payment Factor Details Dialog Box</td>
<td>89</td>
</tr>
<tr>
<td>Custom Physician Payment Factor</td>
<td></td>
</tr>
</tbody>
</table>
Archive All Rates Option Within the Add to Archive Dialog Box 148

Summary Example Within the Add to Archive Dialog Box 149

Delete Icon to Delete Archive 150

Delete Dialog Box 150

Show Details Icon 151

Archive Details Dialog Box 152

Delete Confirmation Message 152

Archive Confirmation Message 153

Rate Manager Pro Production Date in the Search Screen 153

Rate Manager Pro Rate Variable Screen 154

Quick Compare Dialog Box 155

Quick Compare Example 156

Rate Manager Pro Groups Screen 157

Rate Manager Pro Access Setup Dialog Box 158

Audit Trail 160
Index

A
About Optum 6
Accessing Rate Manager 12
ACE Override ID 36
Advanced Filter Criteria Screen 16
Advanced Filters Functionality 15
Advanced Filters Panel 15
All Pay Sources Report 107
Audit Trail Report 103

C
Contact Optum 6
Contact OptumInsight 111
Contact Us 6
Client Services 6
Corporate Address 6
Contract APC 39
Contract ASC 52
Copy/Delete 95
Creating a New Pay-Source Record 24
Creating a New Rate Calculator Record 25

D
Database 123
Database Structure 10
Delete All 124
Do Not Export 98

E
EASYGroup 10
Edit All 93
Editors Overview 35
Event Log 117
Export 131
Export File Names 136
Export Queue 100
Extended FS (Fee Schedule) 64

F
Fee Schedule 55
File Locations 111

G
Global Edit Overview 93
Groups 112
Guide Overview
Document Conventions 5
Introduction to This Guide 5
Intended Audience 5
Organization of This Guide 5

I
Import 128

Introduction 9
Mapping Config 72
Multi-User Lock Functionality 21
National Medical Provider Rate Files (NMPRFs) 10
Optum-Supplied Rate Files 10
Phys Code Table 77
Preferences 120
Pricer Type Details Report 109
Procedure Based Rate Calculator(s) 29
Rate Manager Main/Home Screen 13
Reports Overview 103
State-Specific Rate Files & TRICARE APC Rate Files 10
System Admin Overview 111

W
Web.Strat 9